
Using The Electronic Manual  

Requirements  
The following is a list of system requirements for the electronic manual:  

9 Pentium Processor  
9 64 MB of RAM  
9 50 MB of Available Hard Drive Space  
9 Windows

®

 98 SE, Millenium, NT, 2000, or XP Operating System 
9 CD-ROM Drive  
9 800 x 600 Screen Resolution 
9 AutoCAD

®

 or Volo™ View 2000-129 (Volo™ View is provided on CD)  
9 Adobe

®

 Acrobat
®

 or Acrobat
®

 Reader (Acrobat
®

 Reader is provided on CD)  
 
Opening the Manual  
To open the electronic manual, insert the manual CD into your CD-ROM drive.  The manual startup menu will 
appear. If this is the first time the manual has been used, a disclaimer will have to be acknowledged.  If your CD-
ROM drive is not configured to Auto Run, open Windows Explorer

®

 and open ‘Startupmenu.exe’.

Navigation  
Navigating the electronic manual can be done by clicking on a topic in the left pane.  Several of the topics have 
sub-topics which can be accesses by clicking on the [+] symbol to the left of the parent topic.  The table of 
contents also has links to specific areas of the manual. To search for a specific topic, use the find function by 
keying ‘CTRL+F’. 

Viewing Documents  
The electronic manual uses external documentation for schematics, custom equipment documentation, etc. To 
view these documents, click the link to the specified topic. If the topic is located on an external document, there 
will be a button to access these documents. When you click the button, Adobe

®

 may display a confirmation 
message asking if you want to launch the application used to view the document. Select All, and a list of 
available documents on that topic will appear.  Click the document you wish to view. To return from an external 
document, click on the back arrow for PDF documents. Close the AutoCAD

® 

viewer to return from viewing a 
schematic. All schematics are in a *.dwg format, and all other external documents are in *.pdf format. A 
compatible viewer for each type of document is required to run the electronic manual. 

Troubleshooting  
If you have a problem with the electronic manual, check the following:  

• The electronic manual was started using the ‘Startupmenu.exe’ file.  
• The electronic manual disclaimer has been acknowledged.  
• There is an AutoCAD

®

 compatible viewer installed.  
• There is a Portable Document Format compatible viewer installed (PDF Viewer).  
• The original directory structure has not changed.  
 
If everything in the above list checks out and you are still having problems with the electronic manual, uninstall 
Adobe

®

 Acrobat
®

 (or Adobe
®

 Reader), and AutoCAD
®

 (or Volo™ View), then reinstall each. 
 



Disclaimer  
CAREFULLY READ ALL OF THE TERMS AND CONDITIONS OF THIS DOCUMENT BEFORE 
INSTALLING THIS MEDIA. OPENING OF THIS MEDIA CONSTITUTES ACCEPTANCE OF ALL OF 
THE TERMS AND CONDITIONS OF THIS AGREEMENT.  

If you do not agree to these terms and conditions, you may return this media and the other components of this 
product.  

PRECISION VALVE & AUTOMATION, INC. owns the copyright to this media.  

Copyright© 1997-2004 Precision Valve & Automation, Inc.  

All Rights Reserved.  

This document may not, in whole or in part, be copied, photocopied, reproduced, translated, or copied to any 
electronic medium or machine-readable form without prior consent in writing to Precision Valve & 
Automation, Inc., 15 Solar Drive, Halfmoon, NY 12065.  

Limitation of Liability. In no event will Precision Valve & Automation, Inc. be liable for any damages, 
including lost profits or any special, indirect, incidental or consequential damages, arising out of this 
agreement or the inability to use this media, whether claimed under this agreement or otherwise.  

Nondisclosure. The documents in this media, terms, pricing and all information identified as confidential under 
this Agreement are considered confidential information (“Confidential Information”). Confidential Information 
shall not include information that: a) becomes part of the public domain without breach of this Agreement by 
Customer; b) has been published or is generally known to the public at the time of its disclosure to Customer; c) 
was at the time of receipt otherwise lawfully known to the Customer; or d) is disclosed with the written approval 
of Precision Valve & Automation, Inc. Customer agrees not to make Confidential Information available in any 
form to any third party and not to use Confid ential Information for any purpose other than the implementation of 
this Agreement. Customer agrees to take all reasonable steps to ensure that Confidential Information is not 
disclosed in violation of the terms of this Agreement.  

This Agreement shall be governed by the laws of the State of New York and Customer agrees to submit to the 
exclusive jurisdiction of New York courts. 
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Configuration 

Notice 
This document, including the information contained herein, is the property of Precision Valve & 
Automation, Inc. and is considered confidential and proprietary information.  It is delivered on the 
express condition that it not be used, disclosed, or reproduced in whole or in part, for any reason without 
prior written consent of Precision Valve & Automation, Inc. 

Machine Specifics 
Serial Number:   

Program Revision:   

PathMaster® Version:   

Date of Ship:   

Power Requirements 
Electrical Rating:  

Interrupting Capacity:  

Pressure Settings 

Table 1 – Pressure Settings 

Regulator Description Setting 
   
   
   
   
   
   
   
   
   

Valve Nomenclature 

Table 2 – Valve Nomenclature 

Head # Name Description Z-slide Rotary 
     
     
     
     
     
     
     
     



Optional Equipment 
 
Documentation on non-Standard equipment installed on the workcell is included with this 
manual. To view these documents click the button below. 
 
 
 
 
 
           



Notes 
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 Operation and Maintenance Manual 
 
Warnings, Cautions, and Notes 
Certain warning symbols are affixed to the machine and correspond to notations in this manual.  Before 
operating the workcell, identify these warning labels and read the notices described below.  Not all labels 
may be used on any specific system. 

 

 

Always wear-approved safety glasses when operating or working near 
the workcell.  

 

6040

 

In situations where inattention could cause either personal injury or 
damage to equipment a warning notice is used. 

 
6014

 

Do not smoke near the workcell. Always have a fire extinguisher 
available for emergency use.  

 

6019

 

Before operating the system, read and understand the manuals provided 
with the unit. 

 
6017

 

Before performing any repairs or maintenance to the system, turn off 
power and lock out the power disconnect switch. 

 
6011

 

Never place hands or tools in areas designated by this symbol when the 
machine is in operation.  A dangerous condition may exist. 

 
6008



 

Warning notices are used to emphasize that hazardous voltages, current, 
temperatures, or other conditions that could case personal injury exist in 
this equipment or may be associated with its use.  Only qualified 
personnel should enter areas designated with this symbol. 

6010

 

Before performing any repairs or maintenance to the system, read and 
understand the manuals provided with the unit.  A qualified individual 
should only perform Service. 

 
6018

 

Exercise caution when pressurized vessels are present.  Identify and 
repair any leaks immediately.  Always wear appropriate safety 
equipment when working with pressurized vessels or vessels containing 
chemicals. 

 
6054

 

Laser light source present. Do not stare directly into the beam.  Do not 
use in the presence of highly reflective surfaces. 

 
6003

 

Pinch hazard from moving parts. Avoid contact. 

 
1012

 

Shear hazard from moving parts.  Avoid contact. 

 
1099

 

Hot surface.  Avoid contact. 

 
6043

 

Do not remove protective guarding. 

 
6060



 
This document is based on information available at the time of its publication.  While efforts have been 
made to be accurate, the information contained herein does not purport to cover all details or variations in 
hardware or software, or to provide for every possible contingency in connection with installation, 
operation, or maintenance.  Features may be described herein, which are not present in all hardware and 
software systems.  Precision Valve & Automation, Inc. assumes no obligation of notice to holders of this 
document with respect to changes subsequently made. 

Precision Valve & Automation, Inc. makes no representation or warranty, expressed, implied, or statutory 
with respect to, and assumes no responsibility for the accuracy, completeness, sufficiency, or usefulness of 
the information contained herein.  No warranties of merchantability or fitness for purpose shall apply. 

This document, including the information contained herein, is the property of Precision Valve & 
Automation, Inc. and is considered confidential and proprietary information.  It is delivered on the 
express condition that it not be used, disclosed, or reproduced in whole or in part, for any reason 
without prior written consent of Precision Valve & Automation, Inc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright © 2006 Precision Valve & Automation, Inc. 
All Rights Reserved.



Preface 
Notice & Disclaimer 
This manual applies to one of the following automated workcells produced by Precision Valve & 
Automation, Inc.: 

o PVA250™ 
o PVA250E™ 
o PVA350™ 
o PVA550™ 
o PVA650™ 
o PVA750™ 
o PVA1000™ 
o PVA2000™ 
o PVA2000C™ 
o PVA3000™ 

All machines are referenced throughout the manual as the workcell.  This manual provides information and 
functionality descriptions covering all the common options and configurations for a workcell.  The 
particular machine associated with this manual may not contain all items or may have additions.  If the 
manual refers to an option that was not purchased, ignore that section.  If options exist on the machine not 
mentioned in this manual, please consult the Optional Equipment section of the Operating Guide for more 
information on these additions. 

 

If the equipment is used in a manner not specified by PVA, the 
protection provided by the equipment may be impaired. 
 

Contact 
Main Office   PVA  

   15 Solar Drive 

   Halfmoon NY 12065 

   Tel (518) 371-2684 

   Fax (518) 371-2688 

   Website http://www.pva.net/

   Email mailto:info@pva.net

Technical Support  Tel (518) 371-2684 

   Email mailto:service@pva.net
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Revisions to This Manual 
The following list describes the major revisions in this manual (Rev P 9/07) as compared to the previous 
version: 

o Rewrite for latest program revisions (3.01 & 3.02 & 3.03 & 3.04). 

o Altered Power Check procedure and added Door Interlock Check procedure. 

o Added compatibility for the PVA250™, PVA2000C™, solvent cups, flow monitor, and teach pendant.  
2/10/03 TMB 

o Updated Power Check procedure.  2/10/03 TMB 

o Added PVA750™ references.  8/1/03 TMB 

o Added PVA350™ and PVA650™ references. 3/12/06 PIF 

o Added PVA250E™ references. 8/15/06 PIF 

o Added warning in notice and disclaimers. 9/17/07 RG 
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Content of This Manual 
Introduction.  Provides an overview of the workcell functionality and physical characteristics.

Installation and Setup.  Describes the procedures for installing the workcell and preparing the system for 
use.  Included in this chapter are instructions for unpacking, inspecting, and installing the workcell. 

Operating Safety.  Basic safety practices are reviewed.  The safety devices and guarding for the workcell 
are described. 

Operation.  Describes system operations of the workcell.  It includes a discussion of the system power-up 
and power-down sequences and modes of operation. 

Troubleshooting.  Provides a guide to troubleshooting the workcell.  A fault diagnosis table is used to lead 
the operator through common problems and solutions.  Several troubleshooting procedures are described. 

Maintenance.  Provides a preventive maintenance schedule and replacement procedures. 

 

 

Appendix A – Definitions.  Definitions for commonly used terms. 

Appendix B – Serial Communication.  A brief overview of establishing communication with the workcell. 

Appendix C – Error Codes.  A list of error codes that may be encountered while using the workcell. 

Appendix D – Open Loop Velocity Settings. A list of maximum velocity settings for an open loop drive 
system. 

Appendix E – Wiring Schematic Legend. A legend for the numbering and color coding used in the control 
enclosure for the workcell. 
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Introduction 
System Description 
This manual is intended primarily as a reference for production and operator. However, technical personal 
that is not familiar with PVA equipment find this manual useful for introduction and training.  

The workcell has been designed specifically for applications involving high precision industrial dispensing 
and spray conformal coating.  The flexibility of the machine allows it to be used effectively for a wide 
range of applications. 

The valves are mounted to the end effector of a two, three or four axis Cartesian robot.  All dispensing / 
spraying is performed within the lexan enclosed work area.  Limits have been imposed on the axes to 
prevent damage to the machine.  The dispense / spray path and active heads are controlled by a program 
stored in the motion controller.  The controller can store and retrieve up to 30 programs. 

NOTE: Not all models are equipped with lexan guarding. 

The operator interface (OIT) permits the operator complete control of the machine.  This includes machine 
setup, manual operation, program selection and automatic operation.  Machine status and error messages 
are displayed on the LCD screen and via the optional light tower.  It is necessary that operator(s) have read 
or by training understand the operation of this machine. 

Any uses other than listed above could result in a dangerous condition and cannot be protected against by 
the safety features installed on the system. 

 

 Figure 1 – Workcell Functional Block Diagram  

Safety Precautions 
Operation of your workcell involves air pressure, electrical power and mechanical devices and the use of 
Hazardous materials. Is very important that qualify technicians operating and servicing the system fully 
understand the systems and safety precautions. 
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Year 2000 Compliance 
The workcell is compliant with and comprehends the year 2000-century date change.  The workcell will 
not have any operational impediments, malfunction, cease to perform, generate incorrect or ambiguous data 
and/or produce incorrect or ambiguous results with respect to same-century and multi-century formulas, 
functions, date values and date-data interfaces. 

Intended of Use 
Safety is considered a joint responsibility in between the OEM and the end –user. All precautions and 
practices should be in accordance with local regulations.  

Using the workcell in other ways than is described in this documentation supplied with the equipment may 
result in injury or damage of the equipment. Example of this: 

• Using incompatibles tools 

• Removing doors interlocks or bypassing safety devices 

• Making custom mechanics or fluid delivery modifications 

•  Change material from original design 

 

Emergency Shutdowns 
As a minimum push the EMERGENCY STOP if someone is in immediate danger, or electric shock 

• Unexpected head movement 

• If any PCB are in danger or being damage 

 

Emergency Stop Recovery 
Do not restart operation until the condition that caused the failure is being alleviated.   

• Open the front doors and remove all PCB from the work area  

• Close the doors and pull the stop button out  

• Press F1 to recover power and restart your program by pressing AUTO 

Environmental 

Noise Levels 
The audible noise level of the workcell is below 65 dBA. 
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Materials/Chemicals 
There are no dangerous materials or chemicals used in the operation of the machine except for the required 
application material.  The application material should include a Material Safety Data Sheet (MSDS), which 
specifies known dangers and toxicity. 

 

Hazards Due to Contact 
The workcell is designed in such a way as to minimize injury from contact with any accessible portion of 
the machine.  However, under certain modes of operation, it is possible to enter the work area while the 
motion platform is under power.  Only a qualified person should do this.  All hot surfaces are indicated 
with a warning label. 

Handling, Transportation and Storage 

Handling and Transportation 
Handling and transportation should be done in such a fashion as to minimize the vibration and shock 
introduced to the system.  An air-ride truck is recommended for roadway transport.  Although the machine 
is designed and built to perform in an industrial environment, excessive abuse will greatly impact the 
performance of the machine. 

Storage 

Dust and Debris 
All enclosures and connector covers should be closed tightly.  It is recommended that a cover be place over 
the system if dust or other airborne debris is present in the storage area. 

Temperature and Humidity 
Storage should be done in an area at 40°F - 105°F (4°C – 41°C) and low humidity.  Condensation should 
not be allowed to collect on the machine. 

Dispensing / Spraying Equipment 
Whenever the machine is to be stored for extended periods of time, the workcell should be flushed using a 
solvent compatible with the application material.  This includes the following systems, if applicable: 

o Dispensing valves, spray valves and servo valves. 

o Material lines and hoses. 

o Pressure vessels. 

o Pumping systems. 

o Diaphragm pumps 
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Installation and Setup 
WARNING The following procedures should be performed by qualified persons in 
accordance with this manual and applicable safety regulations.  A “qualified person” is defined as “a 
person or persons who, by possession of a recognized degree or certificate or professional training, 
or who, by extensive knowledge, training, and experience, has successfully demonstrated the ability 
to solve problems relating to the subject matter and work.” (ref. ANSI/ASME B30.2-1983.) 

Tools and Material needed 
The following tools and material will be need for this procedure 

• ½ - Inch Wrench              

• Forklift 

• Work Gloves 

• Tie Wrap cutters 

• Safety Glasses 

• 3 mm hex Key 

• 4 mm hex Key 

• 5 mm hex key 

• Flat Bar 

Uncrating and Inspection 
 

1) Use the flat bar and hammer to remove the top and sides of all four sides of the crate 

2) Remove all packing materials and strapping.  

3) Use the 9/16-inch wrench to remove the following bolts and anchoring the dispensing system to the 
floor of the crate. 

• Two (2) Bolts in each of the foot  (8 Total)  

4) Use a forklift to gentle remove the dispense equipment off the pallet; lift the equipment either from the 
back or the front.  Place forks all the way in and making sure that blade reach from front to back.  

To place the dispense system 
1. Move the dispense system to the location where it will be operated 

2. Adjust the forklift height until the dispense equipment is approximately at the required height. If 
any foot is touches the floor before the forklift reaches the required height. 
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3. Loosen the locking nuts, if necessary. 

4. Once the workcell has reached the approximate required height; make sure that all four levelers 
(feet) are touching the ground. If any feet are not touching the ground, use the crescent wrench to 
lower the feet by turning the feet clockwise. 

5. Gentle lower the workcell and remove the forklift. 

NOTE: It is not necessary to tighten the locking nut at this time. 

Inspection 
1. Open the front doors, and remove all straps, tie wraps, and sponges around the dispense heads. 

2. Thoroughly inspect the exterior of the machine for damage, loose fasteners, etc.  Gently move the 
X & Y axis slide to the center of the work area. At the rear of the machine, inspect all tubing 
connections, gauges, and regulators. 

3. Open the electrical enclosure and visually inspect connectors and components for vibration during 
shipping.  Close the door, as the machine should not operate with the doors open (All accept. 

4. Reinstall the Light tower.  

5. Reinstall flow monitor.  The flow monitor is typically mounted on the rear of the workcell. 

6. Reinstall the main air regulator assembly. 

 

NOTE: Step 3 does not apply to PVA250™ and PVA250E ™ models. 

Leveling the Workcell 
This section describes the procedures for leveling the Workcell. If the workcell is going to use as an in-line 
system, it needs to be leveled and aligned in relation to upstream and downstream systems. This document 
does not include procedures for upstream and downstream systems. Alignment procedures should be 
developed and followed by your facility. 

Tools needed  
The following tools will be needed to level the workcell 

• Level 

• Crescent wrench 

To level the workcell 
1. Place the level in the center of the front conveyor. 

2. Observe the position of the bubble within the level window. Determine if the workcell is level 
from side to side. The bubble should be centered between the two lines. 

TIP   
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If the position of the bubble is positioned to the closer to the right line, the left side of the 
workcell needs to be raised. If the bubble is outside or positioned closer to the left line, the 
workcell needs to be raised to the right side. 

3. If necessary, loosen the locking nut on each foot using a crescent wrench. 

4. Using a crescent wrench, adjust the feet of the workcell by placing the wrench on the flat 
(unthreaded) part of the pedestal and turning in the desired direction until the workcell is level 
from side to side. 

TIP   

Turning the pedestal clockwise raises the workcell. Turning the pedestal counterclockwise lowers 
the   workcell. 

5. Check for level at both ends of the conveyors rail by placing the level along the length of the rail 

6. Put the level across the center of the conveyors rails, with one end on the front conveyors and the 
second end in the back rail. 

7. Look at the position of the bubble within the level window. Determine if the workcell is level 
from front to back 

8. Check the workcell for all corner stability by putting your hands on top of the workcell in one 
corner and pressing down. If one of the feet is not touching the ground the workcell will rock back 
and forth. Adjust the feet so that they are all bearing the weight equally. 

9. After checking the corner, re-level the workcell from side to side and front to back if necessary 

10. Once the workcell is level from front to back and side to side is stable with all four feet bearing 
the weight equally, finger tighten the locking nuts by turning them counterclockwise.  

 

Installing the Teach Pendant and Light Tower 
1. Locate the light tower on the top rear of the workcell 

2. Remove all packaging and material from the light tower including wrapping paper, bubble pack and 
tape. 

3. Locate the existing light tower connection on the top rear of the workcell  

4. Align the mast to the extrusion and tighten using a 5mm hex wrench. 

5. Connect the two ends of the light tower cables. 

6. Locate the Teach Pendant and connect the end into the 15 pin connector located on the front of the 
workcell.  

7. Using a small flat head screwdriver tight the two screws form the Teach Pendant into the threads. 
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Power Up  

Overview 
Once you have performed the preliminary installation of the accessories, you are ready to power up the 
workcell. This section describes the connection of the system to air and power supplies, system power up, 
and subsequence testing procedures that ensure that all system components are functioning and 
communicating properly. 

  

WARNING Failure to comply with electrical specifications can result in damage to the 
machine as well as injury to installation personnel.  Electrical hookup must be made by a qualified 
electrician and must comply with any applicable local standards. 

1) Plug the machine into an appropriate power source as determined by the Machine Specific Information 
section of the Operating Guide or the legend plate on the rear of the machine.  The electrical service 
should be properly grounded, and the power source “clean”.  If there is high power equipment 
operating off the same source, a line conditioner may be necessary.  Errors in machine operation could 
indicate poor quality power. 

WARNING Make sure that the Main Power switch is off before connecting the workcell to 
the facility power source.  

• All Workcells shipped from:  Precision Valve & Automation factory is already equipped to 
handle the voltage being used at the installation site per engineering design. 

2) Locate the main air regulator   

3) Attach the quick-disconnect air hose to the facility air supply, slowly open the facility air valve 

4) Close any access doors and push in the EMERGENCY STOP button.  At the rear of the machine, turn 
on the red air lockout valve (PVA250™ and PVA250E™ models are not equipped with an air 
lockout). 

5) A ¼” NPT female fitting is provided at the rear of the machine (PVA250™ and PVA250E ™ models 
have a ¼” quick disconnect fitting).  Connect to a source of clean, dry air.  A hose of ¼” inside 
diameter is sufficient. 

6) Ground any pressure vessel to earth or the machine.  NOTE:  Precision Valve & Automation 
STRONGLY recommends the machine not be powered on or material added to the pressure vessels 
until they are properly grounded. 

7) Turn on power at the red handled switch on the front or rear of the machine (PVA250™ and 
PVA250E™ models have a black “rocker” switch on the rear next to the power cord). 

8) Perform Safety check and homing routine, press Manual mode and manually move the head around 
the entire work area, making sure that it does not encounter any obstacles during travel. Make sure that 
pneumatic and electrical cables do not impede the heads from travel and are not in danger of being cut 
or snagged.  Please contact Precision Valve & Automation if there are any problems. 

9) Check the valve brackets and make sure that the valve and brackets are tight and that the valve does 
not rock or wiggle in the bracket. 

10) Close Doors. 
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Operating Environment 

Board Sensor Sensitivity Adjustment procedures 
Board sensors are optic sensors located along the length of the front of the conveyors. They are facing 
upward. They detect the presence of a board or part and send the signal to the motion controller. You 
should adjust board sensor sensitivity after initial installation and if the sensors are failing the presence of a 
board. 

Depending upon your system configuration, your workcell may have as many as three board sensors, one 
for each zone (Initial cycle, Spray area, and exit). 

Tools needed  
• Small flat screw driver 

• Production board or sample board that is going to be processed. 

To adjust the board sensors 

1. Place a board on the conveyors rail and check for the sensor sensitivity, then with the flat 
head turn it clockwise to set the gain higher or counterclockwise for less insensitivity. 

2. Run boards both sides (Top and Bottom) . 

Location 
The machine should be installed on a level surface away from standing water, possible over spray and 
overhead leaks. 

Temperature and Humidity 
The machine should be operated in an area at 40°F - 105°F (4°C – 41°C) and low humidity.  Condensation 
should not be allowed to collect on the machine. 

Dip Switch Settings 
NOTE:  During normal operation there is no need to adjust the dip switch settings.  If communications 
between the computer and the controller are not reliable, lower the baud rate on both until 
communications are satisfactory. 

The main RS-232 port on the motion controller must be configured as follows to communicate with the 
host computer: 

Table 1 – DMC-1500 Dip Switch Settings  

Switch Position Description 
MRST OFF Master Reset 
1200 OFF Baud rate selection 
9600 OFF Baud rate selection 
19.2K ON Baud rate selection 
HSHK ON Hardware Handshaking 

(PVA550™, PVA1000™, PVA2000™, and PVA3000™ models) 
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Table 2 – DMC-2200 Dip Switch Settings 

Switch Position Description 
MRST OFF Master Reset 
XON OFF Software Handshaking 

HSHK ON Hardware Handshaking 
9600 OFF Baud rate selection 
19.2K ON Baud rate selection 
38.4K OFF Baud rate selection 
OPT OFF Hardware Option 

ENET OFF Use Ethernet port as default for 
Unsolicited messages. 

(PVA250™, PVA250E™, PVA350™, PVA650™, PVA750™, PVA2000C models) 

CAUTION If hardware handshaking is enabled, the program uses the message command 
and a computer is not attached to the Main RS-232 port, the controller eventually halts.  The 
program included with this machine does not contain any message statements. 

Operator Interface Dip Switch Settings 
NOTE: During normal operation there is no need to adjust the dipswitch settings. 

The operator interface must be configured to communicate with the controller.  The correct settings are 
given in the table below.  These setting enables 9600 baud, 7 data bits, 1 stop bit and 1 start bit. 

Table 3 – OIT Jumper Settings 

Jumper Setting 
E1 A 
E2 A 
E3 B 
E4 B 
E5 A 
E6 B 

Software 
The complete workcell software package consists of several items.  To avoid problems and 
miscommunication, it is imperative every operator understand what each piece of software is and its 
purpose.  For more information about PathMaster® and its features, please consult the separate 
PathMaster® Manual in the Operating Guide. 

Main program file 
A text file containing the commands that runs the workcell.  Under normal circumstances it is not 
necessary to change this file, but if needed it can be opened and edited with any text editor, such as 
Microsoft® Notepad or Word.  The Main program file is downloaded via a drop-down menu in 
PathMaster® but it should NEVER be opened within the PathMaster® software. 
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PathMaster® 
Precision Valve & Automation’s Windows®-based programming software.  It is used to create, maintain 
and download project files for the workcell.  The Operating Guide has a separate section on using 
PathMaster® to program the workcell. 

Project File 
A text file containing the code for one or more programs. In almost all cases this file is created within 
PathMaster®.  This file is downloaded using PathMaster®. 

Machine Communications 
For manufacturing lines (multiple machines utilizing conveyor systems) it is necessary for the individual 
modules to communicate reliably.  Therefore, the SMEMA cables must be connected in the correct 
manner. 

NOTE:  On the diagrams the J# refers to the label on the machine, not the label on the cable. 

SMEMA 
The Surface Mount Equipment Manufacturers Association (SMEMA) Electrical Equipment Interface 
Standard is used to insure proper sequencing of boards.  If these connections are not in place, boards 
cannot move from one machine to another.  

SMEMA cables have male 14-pin amp-type CPC connectors.  The cables are straight through, so 
orientation does not matter. Each machine must have the same transport conveyor height from the floor to 
the bottom of the PC board. For equipment with an adjustable conveyor width, the front rail is fixed and 
the rear rail is adjustable. The range of adjustment will vary with the equipment. To sequence the boards 
properly from machine to machine, one or two signal lines will be used : Board not available and Board 
Available.  On each module, the wire to the J1 (Previous) plug must connect to the J2 (Next) plug on the 
machine upstream.  Similarly, the J2 plug on each machine must connect to the J1 plug on the machine 
downstream, as shown in the following diagram: 

Figure 2 –SMEMA Diagram 
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Operating Safety 
Notices and Warnings 
o Safety glasses, gloves, and long sleeved clothing are necessary precautions when working with 

automated industrial equipment. 

o Read and understand all operating manuals before using this equipment. 

o Do not disable the safety features of the machine. 

o Lock-out and tag the air and power supplies before servicing or cleaning any part of this equipment. 

o Do not remove any hose, either air or fluid, without relieving the pressure. 

o Do not replace any hose with a hose of inadequate pressure rating. 

o Use only replacement parts recommended or supplied by the manufacturer. 

o Always remain clear of all moving parts when the system is in operation. 

Safety Devices and Guarding 
The workcell has several safety features that protect the operator from hazards during normal operation of 
the machine.   

NOTE:  The safety features should NEVER be bypassed, disabled or tampered with. Precision Valve & 
Automation, Inc. is not responsible for any damages incurred, mechanical or human, because of 
alteration or destruction of any safety features. 

Safety Circuit 
The main power to the machine is monitored and controlled by the safety circuit.  The safety circuit 
contains two relays, under-voltage protection, and one or more safety devices.  The relays are wired in a 
redundant manner.  Redundancy consists of two parallel relay circuits which work together electrically 
with the safety devices.  The tripping contacts of the relays are connected in series to insure that the safety 
circuit will disconnect power even if one of the relays has failed.  Self-checking consists of positive guided 
contacts which are mechanically forced to operate together.  If one of the redundant relays fails, the power 
contacts are opened.  The safety devices monitor the state of the EMERGENCY STOP push button and 
other safety mechanisms.  When the safety relay detects that the one or more of the safety devices has 
opened, the power to the motors and pneumatics is cut. 

Lexan Guarding 
The work area is enclosed with Lexan guarding.  The front of the machine is either open, to allow for 
manual part loading and unloading, or guarded by doors. 

Doors 
For machines with an automatic load/unload cycle the front of the machine is protected by two doors.  
Each door is monitored by a non-defeatable limit switch.  When the door is opened power to the motors 
and pneumatics is disconnected.  The DOOR BYPASS key switch is provided to allow maintenance 
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personnel access to the work area without disconnecting power.  This bypass switch only allows access 
during Manual and Calibration modes. 

Light Curtain 
Some machines are equipped with an optional light curtain.  The light curtain is redundant and self-
checking.  The control signals from the light curtain are included as safety devices in the safety circuit. On 
machine power up, the light curtain must be reset by turning the key switch to ‘Reset’ for at least ½ second. 

Exhaust Fan 
Some machines are equipped with an exhaust fan.   The exhaust fan is provided to exhaust fumes from the 
work area.  The exhaust flange should be connected to an appropriate ducting system that is capable of 
receiving 150 CFM (cubic feet per minute).  Insufficient airflow through the exhaust system generates an 
error.    

NOTE: Installed safety devices vary from model to model. 
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Operation 
Startup Procedure 
1) Check the fluid and air pressures.  

2) Close all doors and turn the DOOR BYPASS key switch to the OFF position (If applicable). 

3) Engage the EMERGENCY STOP button. 

4) Turn on main power using the red rotary switch at the front or rear of the machine (Black “rocker” 
switch on PVA250™ and PVA250E™ models). 

Light Tower Operation 
Three stacked indicator lights and a buzzer are used to indicate the status of the machine.  The lights are 
green, amber, and red with green on the bottom, amber in the middle and red on top.  The buzzer is located 
below the green light.  The lights are visible from all sides of the machine.  The indicators operate as 
follows. The light tower may help you be your first clue for solving a problem. 

o The green indicator is on when the machine is in cycle and producing parts.  It is off at all other times. 
o The amber indicator is on when the machine is in Auto Cycle and ready to produce parts, but can not 

cycle due to an external material handling problem (no incoming parts or no room to unload parts).  
PVA750™ and PVA2000C™ models are equipped with a light tower but not an amber light. 

o The red indicator is on steady when the machine is not in Auto Cycle due to operator intervention.  It 
will flash when the machine is in cycle, but cycle is halted due to a machine problem. It is off at all 
other times. 

o The buzzer cycles with the red indicator during machine errors.  

Table 4 – Light Tower & Buzzer Status 

 

State Red Amber Green Buzzer 
Cycle Stop ON OFF OFF OFF 
Auto Cycle OFF ON OFF OFF 
In Cycle OFF OFF ON OFF 
Machine Error FLASH OFF OFF FLASH 

Exhaust Verification 
Once the workcell has initialized, most models will perform an exhaust flow verification process.  If 
initialization fails, consult the section Startup Errors on page 43.  During this process, and whenever the 
workcell is in operation the exhaust flow rate is monitored via the on board pressure differential switch.  
The workcell must exhaust at a rate no less than 150 cubic feet per minute, otherwise a critical fault will 
occur shutting the motors down.  The verification process will also attempt to evacuate any potential 
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vapors that may already exist in the work area of the workcell.  The time this process takes will vary from 
model to model, but the remaining time for the process will be displayed as in the screen below: 

Verifying exhaust. Please wait ... 
                                                                                    060 

F1 F2 F3 F4 F5 F6 F7 F8  

Machine Safety Check 
Once initialize and exhaust verification is complete, the operator interface displays the following message: 

Machine Safety Check
Press F1 to initiate.

F1 F2 F3 F4 F5 F6 F7 F8  
 

The machine safety check ensures the workcell safety devices (emergency stop, door interlocks, light 
curtain, etc.) are operating properly.  During startup, the operator must enter the safety check and complete 
it successfully.  Otherwise, the machine halts all operations.  After pressing F1 the operator is prompted by 
the operator interface to activate and deactivate the safety devices and the POWER ON button, if present.  
Certain events in this procedure are timed and if an action is not performed within a specified time the 
machine interprets this as a failure and displays an error screen such as this: 

EStop button failed.
Press F1 to repeat test.

F1 F2 F3 F4 F5 F6 F7 F8  

By pressing F1 the operator can repeat the test one time.  If a second failure occurs, a screen such as this 
appears: 

EStop button failed.
Repair and restart the machine.

F1 F2 F3 F4 F5 F6 F7 F8  
 

After the second failure the program ceases functioning and the machine must be restarted.  The second 
failure need not be for the same device.  An emergency stop failure followed by a door interlock failure 
halts the program. 

If the safety check fails, the entire system should be thoroughly examined by qualified maintenance 
personnel before the machine is returned to operation. 
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Homing the Axes 

Press F1 to home the system.

F1 F2 F3 F4 F5 F6 F7 F8  
 

After successfully completing the safety check, the operator is shown the above screen.  Pressing F1 homes 
the system and displays the following screen: 

Homing axes.  Please wait...

F1 F2 F3 F4 F5 F6 F7 F8  
 

The axes home in the following order: Z, W, then X & Y simultaneously. 

Standby Position 
Once the machine has completed the homing sequence or finishes a required calibration procedure (if so 
equipped), it moves to the standby position.  Standby is a defined location, DISTINCT from the home 
position, although in some circumstances it may be defined as the same position as home.  In most cases, 
the standby position is placed near the board stop to minimize travel during Auto Cycle.  The workcell 
always returns to the standby position in Cycle Stop.  If the standby position needs to be changed, please 
consult the Main Program Modifications section of the PathMaster® Manual. 

Solvent Cups 
Some workcells has solvent cups installed as an option.  The need for solvent cups is dictated by the 
process by which the workcell will be used for.  When solvent cusp are installed, the Auto Purge feature is 
overridden by the solvent cup routines regardless of the Setup mode settings. 

The solvent cup location varies from model to model, however, the location will be somewhere in the 
workspace of the workcell.  Solvent cups are used as a means of maintaining clean dispense / spray heads.  
In Cycle Stop the heads are situated in the solvent cups.  In Manual mode, the heads are removed from the 
cups and remain out until exiting this mode.  In Auto Cycle the heads lift and run the auto purge routine.  
They return to the solvent cups after a pre-programmed period of inactivity. 

To change the time delay before the heads enter the solvent cups in Auto Cycle, change the variable 
SLP_TM in the Machine-Specific Information section of the Main program.  A value of 1000 equals 1000 
milliseconds or 1 second. 

Flow Monitor System 
Some workcells have a flow monitor installed as an option.  The flow monitor on the workcell measures 
the amount of material moving through the material supply line before it is split to supply the individual 
valves.  It is used as a verification of the dispensing process, not a control of that process, and reports 
excessive deviations from desired values.  The operator determines both the desired material volume and 
allowable deviation. 
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Priming the Flow Monitor 
The flow monitor must be primed prior to use to prevent damage to the unit.  Priming the flow 
monitor minimizes the amount of air that will pass through the unit during initial startup.  Follow the 
procedure below to prime the flow monitor. 

o Fill the pressure vessel with material and seal.  

o Set the material pressure regulator to 0 P.S.I. 

o Turn the inlet air and outlet material valve to the closed position. 

o Disconnect the material line from the inlet port of the flow monitor. 

o Turn the air inlet and material outlet valves to the open position. 

o Slowly increase the material pressure regulator until material flows from the disconnected material 
line. 

o Turn the outlet material valve to the closed position. 

o Bleed pressure for pressure vessel and adjust the material pressure regulator to 0 P.S.I 

o Reconnect the material line to the inlet port of the flow monitor. 

o Open the valve (dispense or spray) using the manual purge procedure outlined in the operations and 
maintenance manual. 

o Turn the material outlet valve to the open position. 

o Slowly increase the material pressure to the target operating pressure. 

o Continue the manual purge procedure for each valve until the material flows free of air. 

Determining the Correct Material Volume 
Before attempting to determine the appropriate material volume, the operator should have a completed path 
program, since any changes to a program alters the flow data results.  With the completed program loaded 
into memory, the operator should enter the Manual mode, position the board correctly with respect to the 
board stops and run a singular cycle.  For more information on the Manual mode, please consult page 21 of 
the Operation and Maintenance Manual.   

After the singular cycle finishes, it displays the following screen: 

Flow Data  Set Pt.=00.00cc Dv.=00.0%
Mat.=00.00cc.  Press F1 to continue.

F1 F2 F3 F4 F5 F6 F7 F8  

The ‘Mat’ value is the amount of material dispensed.  The operator should go to the Flow Control mode 
and change the flow set point to the ‘Mat’ value that appeared on the flow data screen, then return to the 
singular cycle option to run more cycles and verify the consistency of the path program. 

NOTE:  The above screen does not display if the material target level is set to zero in the Flow Control 
mode.  See the section Flow Control Mode for information on changing the material target level. 

Setting the Material Volume Check 
There are two methods of setting the material volume check parameters. 
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1) Go to the Flow Control mode and adjust the material volume and deviation parameters. 

2) Program the settings into the path program.  Two variables are used:  AC_SET and AC_DEV.  
AC_SET is the set point for the material flow, which can range from 0 to 99.  AC_DEV is the percent 
deviation allowed, which can be anywhere from 0 to 99.  As an example, entering the following line 
into a path program:  AC_SET=0.500;AC_DEV=5 would put the volume setting at 0.5 cc and the 
allowable deviation at 5%. 

If the settings are programmed into the path program, they are used instead of the settings from Flow 
Control mode.  If no settings are programmed in the path, the machine defaults to the Flow Control mode 
settings. 

Auto Cycle Flow Error 
The Auto Cycle checks the material flow after every cycle if the error is turned ON in the Flow Control 
mode.  If the volume was within parameters, no indication is given to the operator.  In cases where the 
volume was outside acceptable parameters, the flow error screen appears.  This screen is similar to the flow 
data screen shown above.  The board should be removed before returning the machine to operation. 

NOTE:  Any changes made to settings in the material delivery system (material pressure, stroke 
adjustment, etc.) may affect the data from the flow monitor.  If this happens, the operator may need to 
determine the correct material volume again. 

Flow Monitor Calibration 
Periodically, the flow monitor calibration should be checked.  Start by connecting a PC to the Dispensing 
System, open a terminal screen and enter DEZ=0.  This resets the flow monitor encoder to zero.  Then 
dispense 10 cubic centimeters of material through any valve, by means of a manual purge.  When finished, 
enter MG _DEZ on the terminal screen.  This returns a value representing the number of encoder counts 
read by the flow monitor.  Calculate the flow monitor calibration value: (Encoder Counts / 10) = FC_CAL.  
Change the value of the FC_CAL variable in the Machine-Specific Information section of the Main 
program to the result of the calculation. 

NOTE: For a more precise calibration, determine volume by weight.  The specific gravity or density of 
the material must be known to do this. 

Flow Control Mode 
Flow control mode is typically accessed through the Cycle Stop menu using the F2 function key.  If access 
to Flow Control mode is not achieved through Cycle Stop, or if more than one flow monitor is installed on 
the workcell, documentation in the Optional Equipment section of the Operator’s Guide will provide 
details on these options. 

Flow           00.00cc  DEV=00.0%    Error
EXIT         UP   DOWN   UP  DOWN  *ON   OFF

F1 F2 F3 F4 F5 F6 F7 F8  

Flow mode allows control over the flow monitor data that is used as a process check only during Auto 
Cycle.  These settings are used to determine the material volume and whether or not it is excessive unless 
super exceeded by commands in a path program.  The error selection turns the process verification check 
on and off.  The error ON/OFF selection cannot be overridden by commands in a path program. 

[F1] EXIT – Leave Flow mode and return to Cycle Stop. 
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[F3] cc UP – Increase the material target level.  Maximum is 99 cc. 

[F4] cc DOWN – Decrease the material target level.  Minimum is 0.00 cc. 

[F5] DEV UP – Increase the allowable deviation.  Maximum is 99%. 

[F6] DEV DOWN – Decrease the allowable deviation.  Minimum is 0%. 

[F7] Error ON – Turn the material flow error checking on.  (default) 

[F8] Error OFF – Turn the material flow error checking off. 

 
 

Calibration Procedures  
The workcell has one of three calibration methods:  Standard, Operator Defined and Sensor Defined.  If a 
Sensor Defined or Operator Defined method is installed on the workcell, the machine may or may not 
automatically enter its particular calibration mode following the homing sequence depending on the 
application the workcell was set up for.  See page 31 for particulars on operating the workcell during a 
calibration sequence. 

 

Standard Needle Calibration 
The simplest calibration procedure requires the operator to visually inspect the position of a needle with 
respect to a calibration point (such as cross-hairs).  If the needle is not directly above the point, the operator 
must physically reposition the needle so it is above the calibration point. 

 

Operator Defined Needle Calibration 
This method is dependent upon the operator utilizing the trackball to redefine the coordinate system 
according to the positioning of a specific needle or dispense head.  This process is optional.  If the specific 
needle is located in the desired position this process can be skipped.  

The calibration routine automatically runs when the machine is powered on or if the controller is reset.  
The head moves to a calibration point (specified in the main program).  When at the calibration position the 
operator has control of the axes.  Using the trackball, the position of the needle tip can be redefined in 
reference to a calibration point (such as cross-hairs).  This process can also be run manually through the 
CAL function key if a needle needs to be replaced for any reason during operation. 

 

 

Sensor Defined Needle Calibration 
 
The NCU is referenced from the home position on the gantry.  The start positions for each head to enter the 
NCU are referenced from the cross-hair mark on the top of the NCU.  The coordinates are defined for each 
head using reflective sensors in the NCU.  Z is always calibrated first in a downward motion into the Z 
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sensor.  The X and Y coordinates are then calibrated from this position in reference to the positioning of 
the NCU in the work area.  The needle moves into the next sensor (X or Y) finding the first coordinate, 
then moves to the opposite side of the sensor and finds a second coordinate.  The calibration routine then 
calculates the average of the first and second coordinates and redefines the new position accordingly.  This 
sequence is repeated for the remaining axis. 
 
 

 
 
 

Figure 3 - Needle Sensor Calibration Block 

 

 

Shutdown Procedure 
If the machine is in cycle, wait for the cycle to finish and then return to the Cycle Stop mode.  If the 
machine is in any other mode, the operator should return to Cycle Stop. 

1) Press the EMERGENCY STOP button. 

2) Turn off power to the system.  Rotate the main disconnect switch to the “0” position (Rocker switch 
on PVA250™ and PVA250E™ models). 

3) Clean any excess material from the tips of the needles. 

4) Remove spray cap(s), wipe tip of needle/seat as well, clean cap thoroughly. 

5) If the system will be down for an extended period of time, it is recommended to turn off the air to the 
machine.  The red lockout valve at the rear of the machine can be used for this (not applicable on 
PVA250™ and PVA250E™ model). 

CAUTION If maintenance is to be performed during the shutdown, be sure to lockout and 
tag the machine. 
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Cycle Stop 

Cycle Stop
PROG         CAL  MAN   AUTO  STAT       SETUP

F1 F2 F3 F4 F5 F6 F7 F8  

The Cycle Stop state is the default state for the workcell.  All other modes and capabilities can be accessed 
from this state through the function key buttons listed below. 

[F1] PROG – Change the active program in Program Selection (see page 31). 

[F3] CAL – Enter Needle Calibration mode (see page 31). 

[F4] MAN – Manually operate the machine (see page 32).  Also known as Jog or Teach mode. 

[F5] AUTO – Run the machine in Auto Cycle (see page 34). 

[F6] STAT – Check the status of certain machine items. 

[F8] SETUP – View or change the setup functions of the machine (see page 36). 

Program Selection 

Select Program: Program 1
EXIT  PREV  NEXT

F1 F2 F3 F4 F5 F6 F7 F8  

The workcell is capable of storing up to 30 different programs.  The program selection menu allows the 
operator to choose which program is used during the Auto Cycle mode. 

[F1] EXIT – Leave program selection and return to Cycle Stop. 

[F2] PREV – Decrement to the previous program. 

[F3] NEXT – Increment to the next program. 

Needle Calibration 
The end effector may contain dispense (as opposed to spray) heads, each of which has a needle.  Whenever 
a needle is replaced or the machine is started the needles should be calibrated.  When the machine enters 
this mode it automatically moves to a pre-set calibration point. 

Standard 

Calibration
EXIT        HOME

F1 F2 F3 F4 F5 F6 F7 F8  
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Once at the preset point, the operator must physically reposition the dispense needle to ensure proper 
calibration. 

[F1] EXIT – Leave needle calibration and return to Cycle Stop. 

[F3] HOME – Home the system. 

Operator Defined 

Calibration       AXIS: X&Y
EXIT  RECAL HOME  X&Y    X     Y     Z     W

F1 F2 F3 F4 F5 F6 F7 F8  

The needle(s) must be positioned over a cross hair.  Once the operator is satisfied that the needle is 
properly positioned, selecting RECAL calibrates the system.  The operator can use the trackball to move 
the end effector. 

[F1] EXIT – Leave needle calibration and return to Cycle Stop. 

[F2] RECAL – Execute re-calibration. 

[F3] HOME – Home the system. The workcell returns to the pre-set point. 

[F4] X&Y – Operate the X and Y-axes simultaneously. 

[F5] X – Operate only the X-axis. 

[F6] Y – Operate only the Y-axis. 

[F7] Z – Operate only the Z-axis. 

[F8] W – Operate only the W axis. 

Sensor Defined 

Calibration
EXIT  CAL   HOME

F1 F2 F3 F4 F5 F6 F7 F8  

The sensor-defined calibration is entirely machine run.  No operator intervention is required to execute the 
sequence. 

[F1] EXIT – Leave needle calibration and return to Cycle Stop. 

[F2] CAL – Run the calibration routine.  This is automatic and no operator intervention is required. 

[F3] HOME – Home the system.  This automatically runs the calibration routine afterward. 

Manual Mode 
PVA250E™, PVA350™, PVA550™, 
PVA650™, PVA1000™, PVA2000™, 

PVA250™, PVA2000C™ models 
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PVA3000™ models. 

Jog Mode  Head: FC100           Axis: X&Y 
EXIT  TEACH  VLV   RUN  PURG   TP  CONV  AXIS 

F1 F2 F3 F4 F5 F6 F7 F8  

Manual Mode               Head: FC100 
EXIT  TEACH  VLV   RUN  PURG   RP        JOG 

F1 F2 F3 F4 F5 F6 F7 F8  

 

Manual mode allows manual control of all devices on the workcell.  There are sublevels within Manual 
mode used to access different workcell functions.  The workcell is considered to be in Manual mode even 
when in a sublevel of Manual mode.  Manual mode also serves as the Teach mode for all workcell models.  
Models equipped with a trackball can jog the gantry via the trackball from Manual mode.  An axis 
combination can be selected from the trackball as well as the Axis sublevel.  Models that are not equipped 
with a trackball (PVA250™, PVA750™, PVA2000C™) can jog the gantry using the function keys from 
the Jog sublevel menu. 

Programming the workcell is accomplished in concert with a PC-compatible computer by using Precision 
Valve & Automation’s PathMaster® software.  The operator must be in Manual mode, or a sub level of 
Manual mode, for PathMaster® to function properly.  For more information on programming, please 
consult the separate PathMaster® Manual in the Operating Guide. 

[F1] EXIT – Leave Manual mode and return to Cycle Stop. 

[F2] TEACH – Program the current point.  

[F3] VLV – Switch to Valve Selection (see page 34). 

[F4] RUN – Run singular cycles of the current program.  Pressing F1 exits the mode and returns the 
operator to Manual mode.  In this mode the following screen appears, allowing the operator to run 1 cycle 
either wet or dry: 

Press F2 or F3 to run 1 cycle. 
Exit  WET  DRY 

F1 F2 F3 F4 F5 F6 F7 F8  

[F5] PURG – Actuate the current valve. 

[F6] TP – Momentary switch that displays the current position of the head in the following manner: 

 RP – (PVA250™, PVA750™, PVA2000C™ models only) Momentary switch that displays the current 
reference position of the head in the following manner: 

Current Position: 
X 000000, Y 000000, Z 000000, W 000000 

F1 F2 F3 F4 F5 F6 F7 F8  

[F7] CONV – Switch to Conveyor Control (see page 37). 

[F8] AXIS – Switch to Trackball Control (see page 37). 

 JOG – (PVA250™, PVA750™, PVA2000C™ models only) Switch to Jog Mode (see page 38). 
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Valve Selection 

Valve Functions    Head: FC100 
EXIT  PURG   SEL   UP   DOWN ROTA  ROTB 

F1 F2 F3 F4 F5 F6 F7 F8  

Units equipped with multiple valves have this mode.  The active head or valve can be selected from the 
Valve sublevel menu.  The pneumatics Z-slide(s) and rotary(s) (if equipped) can be actuated from the 
Valve submenu. 

NOTE:  When programming or operating the workcell, the valves should NEVER be used for moving 
components or boards.  Precision Valve & Automation is not responsible for damages incurred from 
using the valves in an inappropriate manner. 

[F1] EXIT – Leave Valve submenu and return to the previous menu. 

[F2] PURG – Actuate the current valve. 

[F3] SEL – Change the active head. 

[F4] UP – Raise the active head’s Z-slide. 

[F5] DOWN – Lower the active head’s Z-slide. 

[F6] ROTA – Put the rotary in the home position. (Default) 

[F7] ROTB – Put the rotary in the auxiliary position. 

Automatic Mode 

Auto Cycle WET        Count:000000
STOP          PROGRAM 1

F1 F2 F3 F4 F5 F6 F7 F8  

This mode handles the automatic cycling of the machine.  There are three machine setups that may be 
encountered: 

o Conveyor equipped. 

o Stand-alone without a light curtain. 

o Stand-alone with a light curtain. 

For a workcell with a conveyor, the part is placed for process on the conveyor either by an operator or 
mechanically via an upstream process.  SMEMA signals are provided with the machine to be used in 
conjunction with an upstream process.  The part is recognized at the entrance to the machine and is shuttled 
to the stop for cycling.  Once against the stop the part is registered and dispensed / sprayed on.  Once the 
program finishes, the board is released and shuttled to the downstream end of the conveyor to await any 
process that may follow.  Once released or removed, the process is set to repeat itself. 

Operation and Maintenance Manual Rev P  9/07 
- 34 - 



For machines without a conveyor, all parts must be placed in the workcell manually.  Part-in-place sensors 
detect if a board is present or not.  If a board is misplaced in the cell, the operator is alerted of the fact.  
Once a machine is ready for cycling, the operator must activate the hand switches to process parts.  All 
parts must be removed after cycling before a new cycle may begin. 

If the workcell possesses a light curtain, it operates in a similar manner as a stand-alone model without a 
light curtain.  However, the light curtain may be used to initiate cycles (bypassing the hand switches). 

Screen during cycle. Screen with valves deactivated. 

In Cycle...           Count:000000 
STOP          PROGRAM 1 

F1 F2 F3 F4 F5 F6 F7 F8  

Auto Cycle DRY        Count:000000 
STOP          PROGRAM 1 

F1 F2 F3 F4 F5 F6 F7 F8  

Status Mode 

Status           SMEMA   Up Ready    DN BA
EXIT        STAT  INP    ON  *OFF   ON   *OFF

F1 F2 F3 F4 F5 F6 F7 F8  

The status mode allows the operator to check a number of machine parameters, running an entire sequence 
when STAT is selected from within this mode.  When the workcell is placed in-line, SMEMA signals 
ensure communication with the upstream and downstream machines.  The operator can check the inputs to 
the workcell and change the Up Ready and Down Board Available output signals. 

[F1] EXIT – Leave Status mode and return to Cycle Stop. 

[F3] STAT – Switch to the Status Sequence (see page 35). 

[F4] SMEMA INP – Check the status of the SMEMA inputs (momentary).  Displays the following screen: 

Up Board Available: OFF
Down Ready: OFF

F1 F2 F3 F4 F5 F6 F7 F8  

[F5] Up Ready ON – Turn the Up Ready signal on. 

[F6] Up Ready OFF – Turn the Up Ready signal off.  (default) 

[F7] DN BA ON – Turn the Down Board Available signal on. 

[F8] DN BA OFF – Turn the Down Board Available signal off.  (default) 

Status Sequence 
The status features are available via the setup mode and whenever the machine encounters a position error, 
limit error or command error.  It gives information on the status of the axes that may be helpful in 
debugging a problem.  Once the operator enters the status mode, exiting is allowed at any time by pressing 
F8, while pressing F1 scrolls the operator through the screens. 
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Machine Status Report.  Press F1 to
scroll through screens, F8 to quit.

F1 F2 F3 F4 F5 F6 F7 F8  

 

Encoder Status (all except PVA250™) Motor Status 

X-axis      Enc.Pos.  Com.Pos.  Pos.Err.   
             000000    000000    000000 

F1 F2 F3 F4 F5 F6 F7 F8  

X-axis Motors    On/Off  Torque  Tor.Lim. 
                   ON    0.0000   0.0000 

F1 F2 F3 F4 F5 F6 F7 F8  

Sensor Status Tuning Status 

X-axis Sensors  Home  For.Lim.  Rev.Lim. 
                 OFF    OFF       OFF 

F1 F2 F3 F4 F5 F6 F7 F8  

X-axis Tuning     KD     KP     KI 
                000.00 000.00 000.00 

F1 F2 F3 F4 F5 F6 F7 F8  

Setup Mode 

Setup   Counter         Auto Purge  Run Mode
EXIT   CNT  RES          ON  *OFF   WET  *DRY

F1 F2 F3 F4 F5 F6 F7 F8  

Setup mode allows the operator to control basic functions of the machine.  The valves can be turned off 
during Auto Cycle by setting the run mode to dry.  This option does NOT affect the run option in the 
Manual mode, which is user selected as a wet or dry run.   

The auto purge feature dispenses / sprays material from all valves at specific intervals to prevent valves 
from clogging.  The auto purge default setting is dependent upon the type of material used in the workcell.  
The workcell only auto purges when in Auto Cycle or Cycle Stop.  If the workcell is in any other state, it 
does not auto purge.  However, it immediately auto purges, if necessary, once returning to Cycle Stop or 
Auto Cycle. 

NOTE: If the workcell is equipped with solvent cups the auto purge feature is overridden by the solvent 
cup routines.  The system will purge only when needed according to the solvent cup sequence, regardless 
of the auto purge setting in Setup mode. 

[F1] EXIT – Leave Setup mode and return to Cycle Stop. 

[F2] Counter CNT – Display the current cycle count. 

[F3] Counter RES – Reset the cycle count to zero. 

[F5] Auto Purge ON – Enable the auto purge feature. 

[F6] Auto Purge OFF – Disable the auto purge feature. 

[F7] Run Mode WET – Dispense / spray material during Auto Cycle. (Default) 

[F8] Run Mode DRY – Material does not dispense / spray during Auto Cycle. 
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Conveyor Control 

Conveyor Control         Conveyor     Stop
EXIT                     ON   OFF   ON    OFF

F1 F2 F3 F4 F5 F6 F7 F8  

The conveyor and stop are controlled in this mode so the operator can position boards in the workcell. 

[F1] EXIT – Leave Conveyor Control and return to the previous mode. 

[F5] Conveyor ON – Turn the conveyor on. 

[F6] Conveyor OFF – Turn the conveyor off. 

[F7] Stop ON – Turn the board stop on. 

[F8] Stop OFF – Turn the board stop off. 

Trackball Control 
(All models except PVA250™, PVA750™, PVA2000C™) 

Trackball Control    Current: X&Y
EXIT  TEACH PURG  X&Y    X     Y     Z     W

F1 F2 F3 F4 F5 F6 F7 F8  

Trackball Control allows the operator to switch the active axis on the trackball. 

[F1] EXIT – Leave Trackball Control and return to the previous mode. 

[F2] TEACH – Program the current point. 

[F3] PURG – Actuate the current valve. 

[F4] X&Y – Operate the X and Y-axes simultaneously. 

[F5] X – Operate only the X-axis. 

[F6] Y – Operate only the Y-axis. 

[F7] Z – Operate only the Z-axis. 

[F8] W – Operate only the W axis. 
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Teach Pendant 
PVA250E™, PVA350™, PVA550™, PVA650™, PVA2000™, and PVA3000™ are equipped with a 
teach pendant which has a trackball, teach button, purge button, axis selection button, and LED indicators 
for selected axes and teach function.   

 

Figure 4 - Teach Pendant 

TRACKBALL – The trackball allows the operator to jog each axis independently or X and Y together. 

Teach – The teach button mimics the teach button found on the workcell OIT in that it will register the 
gantry position back to PathMaster® when teaching a motion profile. 

Purge – The purge button mimics the purge button found on the workcell OIT in that it will purge material 
from the active valve. 

Axis – The axis button allows the operator to toggle through the available axis configurations.  Typical 
configurations are X only, Y only, Z only, W only, and X & Y together. 

LED’s – The X, Y, Z and W LED’s represent the selected axis configuration.  The teach LED indicates a 
successful response from PathMaster® when a position is taught.  The teach LED is accompanied by a 
‘beep’ from the light tower buzzer. 

OIT Jog Control 
(PVA250™, PVA750™, PVA2000C™ models only) 

Jog Mode                     Current: X&Y 
EXIT  TEACH PURG  AXIS  - Y    -X    +X    +Y 

F1 F2 F3 F4 F5 F6 F7 F8  

OIT Jog Control allows the operator to jog the gantry via the OIT function keys to perform teach functions. 

[F1] EXIT – Leave OIT Jog Control and return to the previous mode. 
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[F2] TEACH – Program the current point. 

[F3] PURG – Actuate the current valve. 

[F4] AXIS – Toggle axis control between X, Y and Z. 

[F5] -Y – Jog the Y-axis in the negative direction. 

[F6] -X – Jog the X-axis in the negative direction. 

[F7] +X– Jog the X-axis in the positive direction. 

[F8] +Y – Jog the Y-axis in the positive direction. 

To jog an axis, press and hold the function key that corresponds to the axis and direction of motion desired.  
Once the axis is in motion for approx. 1 sec, the speed will increase by a factor of 15. 
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Fault Recovery 

Recovering from Emergency Stop and Other Machine Errors 
If the operator uses one of the EMERGENCY STOP push buttons or the machine encounters a system error, 
this procedure should be followed to return the machine to the Cycle Stop state. 

NOTE: The PVA250™, PVA750™, and PVA2000C models will require the workcell to rehome after 
recovering from and EMERGENCY STOP, or any other error. 

WARNING If the EMERGENCY STOP was activated because of system failure, DO NOT 
release the EMERGENCY STOP.  Shutdown the system and have qualified personnel repair the 
machine. 

Emergency Stop. Reset button
to continue the program.

F1 F2 F3 F4 F5 F6 F7 F8  

1) After reset, press F1 to return the head to the standby position.  The screen returns to Cycle Stop. 

Press F1 to return head to standby.
 OK

F1 F2 F3 F4 F5 F6 F7 F8  

2) Correct the fault which prompted the operator to emergency stop the machine (open the door, etc). 

3) Open the access door. 

4) Remove all parts from the work area.  Determine which parts can be re-worked and put them in the 
input queue. 

5) Close the access door. 

6) Follow the Startup Procedure. 

Recovery from a door error, resulting from a door being open while the DOOR BYPASS switch is in the 
OFF position, is handled in a similar manner as an emergency stop.  Depending upon the machine setup, 
other errors could occur, such as low air pressure, low material flow or insufficient exhaust air flow.  As 
with an emergency stop, these errors should be corrected first, then the operator should follow the startup 
procedure to continue. 

Examples of the other possible error screens: 

Door Error Low Air Pressure 

Left Door open. Close 
to continue the program. 

F1 F2 F3 F4 F5 F6 F7 F8  

Air Pressure low. Repair 
to continue the program. 

F1 F2 F3 F4 F5 F6 F7 F8  
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Low Material Level Low Exhaust Flow 

Material A Level low. 
Press F1 to continue. 

F1 F2 F3 F4 F5 F6 F7 F8  

Exhaust Flow low. 
Repair and press F1. 

F1 F2 F3 F4 F5 F6 F7 F8  

Low Air Pressure  
There is an air pressure gauge mounted on the main regulator at the rear of the machine, which may 
include a low-pressure sensor.  This is designed as a gross check to verify the main air pressure is being fed 
to the machine.  This prevents damage to moving parts on the end effector.  It does not detect slight 
fluctuations in line pressure but it does detect brief dips below the set point.  If such an instance occurs, the 
machine goes to error for five seconds, then clears the error.  The operator must either increase the air 
pressure or decrease the set point to prevent such an error from happening again. 

If any air pressure error is encountered, follow these steps to return the machine to normal operation: 

1) Verify that the air pressure is ON. 

2) Check that the main air pressure regulator is set for 80-100 P.S.I. 

3) If the above settings are correct, and the output light indicator on the air pressure gauge is still lit, 
verify the set point for the air pressure alarm.  Consult the separate are pressure sensor manual for 
information on setting the air pressure set point. 

4) Adjust the set point for approximately 65-75 P.S.I. 

5) Restart the machine. If the error persists, the air pressure sensor may be damaged. 

Low Material Level 
The workcell only checks the material level(s) when running cycles.  If there is a material level error, the 
machine can operate in all its modes (except for cycles) until the material level is reestablished. 

Resetting the Exhaust Fan Overload Relay 
Machines with exhaust fans may encounter errors when the overload relays trips.  Follow these steps to 
return the machine to normal operation: 

1) Turn machine power OFF. 

2) Open the electrical enclosure. 

3) Check the tripped flag on the overload relay. 

4) Verify that the current set point is set properly on the overload relay.  Check the rating on the exhaust 
fan housing for current draw. 

5) If necessary, push the reset button to reset the relay. 

6) Restart the machine.  If the problem persists, consult the Troubleshooting section on page 46 for more 
information. 
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Pneumatic Error Recovery Procedure 
The system pneumatics is checked for errors any time they operate.  In addition, any movements to home 
or the standby position require the pneumatics to be in their “home” position before proceeding.  If a 
pneumatic fails, it generates an error such as the one below. 

FC100 Z-slide down failed.
Repair and press F1.

F1 F2 F3 F4 F5 F6 F7 F8  

The operator should determine the cause of the problem before pressing F1 and continuing.  Refer to the 
pneumatic actuator failure section of Troubleshooting (page 46) for more information about diagnosing the 
problem. 

Run-Time Error Recovery Procedure 
A run-time error is generated during the execution of the program. For more information about 
programming, please refer to the separate PathMaster® Manual. This type of failure should not be 
encountered during normal operation of the machine.  The most common cause for this type of failure is 
when using PathMaster® ver. 2.1 or higher and attempting to playback an area function without first 
downloading a properly formatted project file to the workcell.  The operator can check the machine’s status 
screens by selecting F5. 

Error 000 on line 0000.
Press F1 to restart, F5 for status.

F1 F2 F3 F4 F5 F6 F7 F8  

Position Error Recovery Procedure 
(All models except PVA250™, PVA750™, PVA2000C™) 

A position error is caused when the difference between the commanded position and the current position 
exceeds the maximum allowable error for an axis.  The error limit is defined to be approximately 1/5”.  For 
most cases this is 1000 count.  The error limit can be reached if the dispense / spray head reaches a hard 
stop, in Manual mode, if the speed or acceleration is set too high or if the axes drives are not powered.  
Check the EMERGENCY STOP button.  The operator can check the machine’s status screens by selecting 
F5. 

Position Error. F1-restart, F5-status.
Stop codes (x,y,z,w) 000, 000, 000, 000

F1 F2 F3 F4 F5 F6 F7 F8  

1) Open the access door. 

2) Move the dispense / spray head to the center of the work area.  The Z-axis is equipped with a brake.  
The motor coupling can be turned by hand to move the head towards the center of the work area. 
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3) Close the access door. 

4) Press F1 to clear the error. 

5) Follow the startup procedure. 

Limit Error Recovery Procedure 
The machine encounters a limit error in the following cases.  First, if the path program attempts to move 
the dispense / spray head past one of the software limits.  If a software limit caused the error, then either 
the path or the software limits must be changed. The operator can check the machine’s status screens by 
selecting F5. 

Limit Error. F1-restart, F5-status.
Stop codes (x,y,z,w) 000, 000, 000, 000

F1 F2 F3 F4 F5 F6 F7 F8  

1) Open the access door. 

2) Move the dispense / spray head to the center of the work area.  The Z axis is equipped with a brake (all 
model except PVA250™ and PVA250E™).  The motor coupling can be turned by hand to move the 
head towards the center of the work area. 

3) Close the access door. 

4) Press F1 to clear the error. 

5) Follow the startup procedure. 

Stop Codes 
(All models except PVA250™, PVA750™, PVA2000C™) 

For Position and Limit Errors, the error screen displays the stop codes for all the motors.  This information 
tells the operator which axis (or axes) caused the machine to go to fault. 

Table 5 – Stop Code Definitions 

Code Meaning
0 Motors are running, independent mode.
1 Motors stopped at commanded independent position. 
2 Decelerating or stopped by FWD limit switch or software limit, FL. 
3 Decelerating or stopped by REV limit switch or software limit, BL. 
4 Decelerating or stopped by Stop Command (ST). 
6 Stopped by Abort input. 
7 Stopped by Abort command (AB). 
8 Decelerating or stopped by Off-on-Error (OE1). 
9 Stopped after Finding Edge (FE). 

10 Stopped after Homing (HM). 
50 Contour running. 
51 Contour Stop. 
99 MC timeout. 

100 Motors are running, vector sequence. 
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101 Motors stopped at commanded vector.
 

Startup Errors 
The program saves several variables in the EEPROM through power-down.  If the variables are not present 
or they are out of bounds the following message is displayed.  The program automatically initializes the 
variables and recover from the error. 

Variable error.
Initializing...

F1 F2 F3 F4 F5 F6 F7 F8  

If the error occurs more than one time during the startup of the machine, the following message is 
displayed.  This indicates a bug in the main program.  The original program should be downloaded to the 
controller. 

Unrecoverable variable error during
startup.  Restart the machine.

F1 F2 F3 F4 F5 F6 F7 F8  

Another potential error occurs when the machine “hangs” on initialization, displaying the following screen 
(which never changes):  

Precision Valve & Automation, Inc.
System Initialization, please wait...

F1 F2 F3 F4 F5 F6 F7 F8  

In almost all cases, this occurs when a program’s length exceeds the maximum available space in RAM or 
a defective function key.  The solution for this problem is to shorten the active program, or replace the 
function key membrane panel.  Consult the separate PathMaster® Manual in the Operating Guide for more 
information on altering a program. 

Subroutine Error 
A Subroutine error occurs if the path programs have not been loaded correctly into segment 1, 2 or 3 of 
memory.  During the Startup Sequence and after Program Selection the main program attempts to load the 
current program from the segment memory.  If the subroutine can not be found the following message is 
displayed.  Please refer to the PathMaster® Manual for more information about downloading. 

Subroutine error.  The subroutine is not
stored in segment 1, 2 or 3.

F1 F2 F3 F4 F5 F6 F7 F8  
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Troubleshooting 
If Something Goes Wrong . . .  
Some problems encountered when using the workcell are easy to identify and solve.  Others require more 
extensive help.  This troubleshooting section is designed to assist an operator in solving problems before 
seeking additional help.  It is strongly recommended the operator check this section first if a mechanical or 
electrical problem occurs.  If you experience problems that are not listed in this section, or continue after 
trying different methods, please contact PVA Customer Service. Remember, not every problem can be 
described in this section, but this should be a good place to start. 

NOTE:  If a problem occurs while running a particular path program, consult the separate 
PathMaster® Manual for information on debugging code problems. 

Calling Technical Support 
The technical support staff is always available to help solve any problems.  The phone number is (518) 
371-2684.  To assist in the troubleshooting process, it is best if as many of the following items are 
addressed before calling for help: 

1) Record all the information on the OIT when the error occurred. 

2) Take note of the operation in progress when the machine developed trouble (when did it have 
problems, what was it doing, etc.). 

3) If the error was not serious, attempt to repeat the error.  If the error does not repeat, the problem may 
have been operator generated. 

4) Use a terminal screen to communicate with the controller.  Most troubleshooting necessitates issuing 
commands directly to the controller. 

5) If the problem is programming related, a hard copy or email of the program in question may be 
requested by PVA.  Please be prepared to send it.  The PVA fax number is (518) 371-2688, or the 
customer service representative will provide an email address, if all parties are email capable. 

Records 
Any service or replaced components should be recorded in maintenance records and any other pertinent 
data for future reference. 

Fault Diagnostic 
The PVA250E™, PVA350™, PVA550™, PVA650™, PVA1000™, PVA2000™, and PVA3000™ 
models use a closed loop servo drive system were as the PVA250™, PVA750™ and PVA2000C™ models 
use an open loop stepper drive system.  Listed below are general fault diagnostic table for each type of 
system. 

Closed Loop Servo Systems 

Table 6 – PVA250E™, PVA350™, PVA550™, PVA650™, PVA1000™, PVA2000™ and PVA3000™ 
systems Fault Diagnosis 
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Operation Other Symptoms Possible Cause Corrective Action 
Turn the machine 
ON.  The operator 
interface does not 
have power. 

 Cables are loose or not 
connected. 

• Check the cable 
connections. Correct any 
loose connections. 

 The electrical 
enclosure does not 
have power. 

The electrical enclosure is 
open, so the electrical 
enclosure safety switch is in 
the open position. 

• Close the electrical 
enclosure. 

  Blown fuse. • Check FU-1 which is 
located inside the electrical 
enclosure.  Replace if 
necessary. 

Homing the axes.  
The end effector 
moves past the 
home sensor and 
hits the hard stop. 

 Home sensor is out of 
position or too far away 
from the homing tab. 

• Depress the EMERGENCY 
STOP push button.  Move 
the axis by hand until the 
homing tab moves into the 
home sensor.  The sensor 
should be on. Loosen the 
lock nut on the sensor and 
readjust to .020” gap. 

  Sensor cable is loose or not 
connected. 

• Check the cable 
connections.  Correct any 
loose connections. 

Homing the axes.  
The Z axis does 
not move. 

End effector can 
be moved freely 
when the power is 
on. 

The EMERGENCY STOP 
push button is depressed. 

• Release the EMERGENCY 
STOP push button. 

 SSR-1 is not ON 
when the Z axis 
drive is enabled. 

The Z axis brake is not 
disengaging when the drive 
is enabled. 

• Check the SSR-1 wiring.  It 
should be on when the Z 
axis drive is enabled. 

 SSR-1 is ON when 
the Z axis drive is 
enabled. 

The fuse for SSR-1 is blown 
or SSR-1 is damaged. 

• Check the fuse using an 
OHM meter.  Replace 
component if necessary. 

Axis does not have 
any Motion 

Encoder works 
according to the 
Encoder Feedback 
Test on page 58. 

The axis speed or 
acceleration has been set to 
zero. 

• Set the speed and 
acceleration to a positive, 
non-zero value using the SP 
and AC commands. 

 Axis drive light is 
RED. 

Axis drive is not enabled. • Enable the drive using the 
SH command. 

  The axis cables are loose or 
not connected. 

• Check the cable 
connections.  Correct any 
loose connections. 
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Operation Other Symptoms Possible Cause Corrective Action 
  The EMERGENCY STOP 

push button is depressed. 
• Release the EMERGENCY 

STOP push button. 

  Hall effect sensors are not 
correctly connected. 

• Check the cable 
connections for the axis.  
Correct any loose 
connections. 

• Check the hall effect sensor 
phasing using the electrical 
drawings. 

  The axis amplifier is bad. • Replace the amplifier. 

  Doors are open • Close doors firmly 

Axis runs away.  Motor power connections 
are wired incorrectly. 

• Check the phasing using the 
electrical drawings. 

 Z axis encoder 
does not work. 

Z axis encoder/brake cable 
is loose or not connected. 

• Check the cable 
connections.  Correct any 
loose connections. 

  The axis amplifier is bad. • Replace the amplifier. 

Pneumatic 
actuator failure. 

Pneumatics work 
slowly. 

Air lockout valve on the rear 
of the machine is in the OFF 
position. 

• Turn the lockout valve to 
the ON position. 

  Insufficient air pressure. • Check and adjust the 
system pressures to the 
correct values.  Please refer 
to the Machine Specific 
Information section of the 
Operating Guide for 
particular pressure settings. 

  Restricted air line. • Correct any tight bends or 
restrictions in the air lines. 

  Loose Fitting or Tubing 
Connection. 

• Tighten connection. 

  Frayed or damaged air line. • Replace the damaged air 
line(s). 

  Sensor is not positioned 
correctly. 

• Adjust the sensor location. 

Part in place 
sensor failure. 

 Cable is loose or not 
connected. 

• Check the cable 
connections.  Correct any 
loose connections. 

Conveyor does not  Conveyor belt stuck to rails. • Clean or replace belt. 
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Operation Other Symptoms Possible Cause Corrective Action 
run.  

 No power to 
conveyor motor. 

Control relay not energized 
or Power On light not 
illuminated (Certain 
Models). 

• Check voltages and 
connections. 

   • Check conveyor power 
fuse. 

Exhaust fan does 
not run. 

No air flow. The motor overload relay, 
OL-1, is in the tripped state. 

• Reset the exhaust fan 
overload relay. 

   • Check FU-5 in the electrical 
enclosure. 

  Insufficient air flow 
capacity in the factory 
ducting. 

• Upgrade the duct to allow 
for more air flow. 

• Reset the exhaust fan 
overload relay. 

 The filter and 
ducting are fine.  
The motor 
temperature is 
normal. 

The overload relay current 
setting has been changed. 

• Verify the current setting on 
the overload relay.  Please 
refer to exhaust fan setup. 

• Checked the tripped flag on 
the overload relay.  Push 
the reset button to reset the 
relay. 

 

Open Loop Stepper Systems 
 

Table 7 – PVA250™, PVA750, and PVA2000C Fault Diagnosis 
 

Operation Other Symptoms Possible Cause Corrective Action 
Turn the machine 
ON.  The operator 
interface does not 
have power. 

 Cables are loose or not 
connected. 

• Check the cable 
connections. Correct any 
loose connections. 

 The electrical 
enclosure does not 
have power. 

The electrical enclosure is 
open, so the electrical 
enclosure safety switch is in 
the open position. 

• Close the electrical 
enclosure. 

  The secondary disconnect if 
off (PVA750™, 
PVA2000C™ only). 

• Check the secondary power 
disconnect located on the 
left side of the electrical 
enclosure in the rear of the 
machine. 
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Operation Other Symptoms Possible Cause Corrective Action 
  Blown fuse. • Check FU-2, FU-3, FU-4 

which is located inside the 
electrical enclosure.  
Replace if necessary. 

Homing the axes.  
The end effector 
moves past the 
home sensor and 
hits the hard stop. 

 Home sensor is out of 
position or too far away 
from the homing tab. 

• Depress the EMERGENCY 
STOP push button.  Move 
the axis by hand until the 
homing tab moves into the 
home sensor.  The sensor 
should be on. Loosen the 
lock nut on the sensor and 
readjust to .020” gap. 

  Sensor cable is loose or not 
connected. 

• Check the cable 
connections.  Correct any 
loose connections. 

Limit Error 
during homing 
sequence. 

Axes is not 
moving. 

The amp fuse(s) is blown. • Check F1-F5 fuses located 
on GPIO interface board. 

  Amp cables are loose or 
disconnected 

• Check J9 and J11 
connections on GPIO 
interface board. 

  Motor Cable(s) are loose or 
disconnected 

• Verify CPC connections at 
motor and terminal 
connections on amp. 

X, Y or Z axis does 
not move. 

End effector can 
be moved freely 
when the power is 
on. 

The EMERGENCY STOP 
push button is depressed. 

• Release the EMERGENCY 
STOP push button. 

 LCD Screen 
indicates that the 
system is running 
normally. 

The amp fuse(s) is blown. • Check F1-F5 fuses located 
on GPIO interface board. 

  Amp cables are loose or 
disconnected  

• Check J9, J10 and J11 
connections on GPIO 
interface board. 

  Motor Cable(s) are loose or 
disconnected 

• Verify CPC connections at 
motor and terminal 
connections on amp. 

Axis Looses 
position. 

 The axis speed or 
acceleration has been set to 
too high. 

• Check speed, acceleration 
and deceleration settings. 

• Refer to Appendix D for 
speed, acceleration 
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Operation Other Symptoms Possible Cause Corrective Action 
deceleration charts. 

  Coupling is slipping. • Check coupling connection 
at motor and ball screw.  
Tighten if needed. 

  The axis amplifier is bad. • Replace the amplifier. 

  Incorrect AC voltage. • Check the power source 
supplied to the workcell. 

• Check the power entry 
module for correct 
configuration. 

Pneumatic 
actuator failure. 

Pneumatics work 
slowly. 

Air lockout valve on the rear 
of the machine is in the OFF 
position. 

• Turn the lockout valve to 
the ON position. 

  Insufficient air pressure. • Check and adjust the 
system pressures to the 
correct values.  Please refer 
to the Machine Specific 
Information section of the 
Operating Guide for 
particular pressure settings. 

  Restricted air line. • Correct any tight bends or 
restrictions in the air lines. 

  Loose Fitting or Tubing 
Connection. 

• Tighten connection. 

  Frayed or damaged air line. • Replace the damaged air 
line(s). 

  Sensor is not positioned 
correctly. 

• Adjust the sensor location. 

Part in place 
sensor failure. 

 Cable is loose or not 
connected. 

• Check the cable 
connections.  Correct any 
loose connections. 

Conveyor does not 
run. 

 Conveyor belt stuck to rails. • Clean or replace belt. 

 

  W axis amp fuse(s) is 
blown. 

 

• Check F4 fuse located on 
GPIO interface board. 

  Amp cables are loose or 
disconnected 

• Check J10 and J11 
connections on GPIO 
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Operation Other Symptoms Possible Cause Corrective Action 
interface board. 

  Motor Cable(s) are loose or 
disconnected 

• Verify CPC connections at 
motor and terminal 
connections on amp. 

Exhaust fan does 
not run. 

No airflow. The motor overload relay, 
OL-1, is in the tripped state. 

• Reset the exhaust fan 
overload relay. 

   •  

The exhaust fan 
overload relay 
trips frequently. 

Excessive motor 
heating. 

Insufficient air 
flow. 

Blocked exhaust filter leads 
to excessive motor heating.  
The overload relay trips. 

• Clean the air filter on the 
exhaust intake. 

• Reset the exhaust fan 
overload relay. 

  Insufficient air flow 
capacity in the factory 
ducting. 

• Upgrade the duct to allow 
for more air flow. 

• Reset the exhaust fan 
overload relay. 

 The filter and 
ducting are fine.  
The motor 
temperature is 
normal. 

The overload relay current 
setting has been changed. 

• Verify the current setting on 
the overload relay.  Please 
refer to exhaust fan setup. 

• Checked the tripped flag on 
the overload relay.  Push 
the reset button to reset the 
relay. 

 

 

Controller Master Reset 
Performing a controller master reset returns the Galil controller to factory defaults.  All memory, variables 
and settings stored in the controller are lost.  DO NOT perform this operation unless the operator 
understands how to download the main program and dispense / spray programs.  This operation cannot be 
undone. 

1) Turn the machine OFF. 

2) Open the electrical enclosure.  

3) Locate the DIPswitches on the Galil controller. 

4) Move the MRST (master reset) switch to the ON position. 

5) Turn the machine ON. 

6) Wait for 20 seconds. 
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7) Turn the machine OFF. 

8) Move the MRST (master reset) switch to the OFF position. 

9) Close the electrical enclosure. 

10) Turn the machine ON. There should be no display on the operator terminal. 

11) Open a terminal screen and enter the LS (List) command.  The controller should return 000 after 
pressing ENTER.  This verifies that the controller is now at factory default and the memory is 
clear.The controller is ready to accept the main program and a project. 

Adjusting or Tuning the internal 5V power Supply 

Figure 5 - Adjusting 5V power supply 

 

6 bolts used to keep 
cover in place. 
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Voltage adjustment 
– potentiometer. 

5Vdc Power Supply. 

 

Request Controller Version 
Perform the following procedure to request the controller firmware version using the PathMaster® 
terminal. 

1) Establish communication with the controller.  Please refer to the PathMaster® Manual. 

2) Open the PathMaster® terminal. 

3) Type ‘^R^V’  

4) Press Enter. 

The controller version is displayed in the terminal window. 

Flexible coupling  
Servo couplings are compensating couplings with a backlash free and conformal torque transfer providing 
high torsional stiffness and a low moment of inertia. Check periodically if a shifting is suspected. 

Figure 6 - Flexible Coupling 
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Flexible 
Coupling 

 

Amplifier cards and 48 Volts Power supply 
Figure 7 - Amplifier Cards and 48V power supply 

48 Volts Power Supply 

All amplifier cards have the same values and it can be interchang
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EEPROM Upgrade Procedure 
(All models except PVA250™, PVA750™, PVA2000C™) 

The EEPROM firmware for the controller is periodically updated.  If new features are added to the 
program or machine it may be necessary to upgrade the firmware.  DO NOT perform this procedure unless 
the operator is skilled with replacing chips. Precision Valve & Automation, Inc. is not liable for any 
damage caused to the controller. 

1) Turn the power OFF and open the electrical enclosure. 

2) Disconnect all the cables from the DMC-1500 controller and remove the controller from the drawer. 

3) Remove the protective metal cover. 

4) Avoid any danger of static discharge damage during handling of the controller circuit board and 
EEPROM chips by wearing a ground strap. 

5) Remove the EEPROM chips from the controller and replace with new EEPROMs, making sure to 
place the L and H labeled chips in the L and H labeled sockets. 

6) Perform a Master Reset so that the controller recognizes the new EEPROM firmware.  Please refer to 
the  

7) Controller Master Reset procedure on page 52. 

8) Return the old EEPROMs to Precision Valve & Automation.  PVA must have the old EEPROMs back 
in order to continue service in the future. 

Conveyor Speed control 
Locate the control cabinet and using a flat screwdriver adjust the speed on the POT R1 clockwise will 
increase the speed and counterclockwise will slow down the conveyor.  (All models except PVA250™, 
PVA250E™ ) 

Figure 8 - Conveyor Control Circuit 
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Power Check 
(All models except PVA250™, PVA250E™, PVA750™, PVA2000C™) 

If the expected voltages are not present in the following tests TURN T
IMMEDIATELY.  Permanent damage to the components may occur. 

1) Remove all of the fuses in the enclosure, except for FU-1. 

2) Disable the enclosure power safety switch. 

3) Turn the machine ON. 

4) Use a DMM (Digital Multi Meter) to check the AC power in the machine.  
VAC between the 100 and 101 terminals.  If not, turn off the power and che
and operational. 

5) Turn the machine OFF. 

6) Install all of the fuses in the enclosure. 

7) Push the EMERGENCY STOP push button in. 

8) Turn the machine ON. 

9) CRM-1 and CRM-2 should be DISENGAGED. 

10) Check for 5 VDC between 304 (+) and 303 (-). 

11) Check for 24 VDC between 306 (+) and 302 (-). 

12) Check for 0 VDC between 307 (+) and 302 (-). 

13) Pull the EMERGENCY STOP push button out. 
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ck that FU-1 is installed 



14) Put a jumper wire between terminal 4 on the 5 V Monitor relay SSR-5 relay and any 304 terminal 
block (this will engage the SSR-5 relay).  If the SSR-5 relay LED is not on, there may be a problem 
with the SSR-5 relay or the wiring on the coil side. 

15) CRM-1 and CRM-2 should be ENGAGED.  If not, check the next section (Door Interlock Check) for 
machines equipped with doors. 

16) Check for 24 VDC between 307 (+) and 302 (-). 

Door Interlock Check 
(All models except PVA250™, PVA250E™, PVA750™, PVA2000C) 

1) Engage the Door Bypass switch.  If CRM-1 engages when the Door Bypass switch is engaged, there 
may be a failure in the left door interlock switch, the right door interlock switch, or their wiring. 

2) Check for a red indicator light on the 5 V Monitor relay SSR-5.  If the indicator is not lit, there may be 
a failure in the 5 V monitor relay or its wiring. 

3) Check for 24 VDC between 504 (+) and 302 (-).  If 24 VDC is not present, there may be a failure in 
the 5 V Monitor relay, the EMERGENCY STOP push button PB-1, or their wiring. 

4) Check for 24 VDC between 505 (+) and 302 (-).  If 24 VDC is not present, there may be a failure in 
the left door interlock switch or its wiring. 

5) Check for 24 VDC between 506 (+) and 302 (-).  If 24 VDC is not present, there may be a failure in 
the right door interlock switch or its wiring. 

6) If 24 VDC is present between 506 (+) and 302 (-), there may be a failure in the coil of CRM-1 or a 
short in its associated diode D-1, or there may be a failure in the coil of CRM-2 or a short in its 
associated diode D-2. 

Encoder Feedback Test 
(All models except PVA250™, PVA750™, PVA2000C) 

Use this procedure to test the encoder feedback for all of the axes.  If a problem is found with any of the 
encoders repair and report the error to the production supervisor. 

Most encoders used with the workcell generate 5080 counts/inch.  Check to make sure that the position 
feedback is reasonable. 

(500*4 counts/rev)*(1 rev/cm)*(2.54 cm/in) = 5080 counts/inch. 

1) Open a terminal program and establish communication with the DMC-1500 controller. 

2) Turn the machine OFF.  Disconnect the black motor power cables.  Leave the orange encoder 
feedback cables attached. 

3) Move all of the axes to the center of travel position. 

4) Turn the machine ON. 

5) Enter HX. 

6) Define the current position as (0, 0, 0, 0).  Enter DP*=0. 
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7) Move the X-axis in the positive direction and display the current position.  Enter TP. 

8) Move the X-axis in the negative direction and display the current position. 

9) Move the Y-axis in the positive direction and display the current position. 

10) Move the Y-axis in the negative direction and display the current position. 

11) Move the Z-axis in the positive direction and display the current position. 

12) Move the Z-axis in the negative direction and display the current position. 

13) Move the W axis in the positive direction and display the current position. 

14) Move the W axis in the negative direction and display the current position. 

15) Turn the machine OFF. 

16) Reconnect the motor power cables. 

17) Turn the machine ON. 

Motor Feedback Test 
(All models except PVA250™, PVA750™, PVA2000C) 

Use this procedure to verify that the motor power and hall effect sensors are wired correctly.  If a problem 
is found with any of the axes, repair and report to the production supervisor. 

1) Turn the machine ON. 

2) Enable the EMERGENCY STOP button.  This cuts the power to the amplifiers. 

3) Open a terminal program and establish communication with the DMC-1500 controller.  This can be 
accomplished via the ‘terminal’ option in PathMaster®. 

4) Enter the following commands via the terminal screen.  The motors may be wired incorrectly.  The 
following program limits the acceptable error and power available to the amplifiers.  This protects 
personnel and equipment. 

OE*=1 Off on error enabled for all axes. 
ER*=1000 Error limit for all axes. 
TL*=1 Torque limit of 1 for all axes. 
SP*=5000 Set the speed. 
AC*=10000 Set the acceleration. 
DP*=0 Define the current position as (0, 0, 0, 0). 
SB5 Enable power (only on machines without a 

POWER ON button). 
SH Apply power to the servo motors. 

5) Release the EMERGENCY STOP push button.  Push the POWER ON button (if present) so it lights up.  
This restores power to the amplifiers.  Care must be taken because any of the axes can move at this 
time. 

6) Command the X-axis to make a positive move.  If the axis runs away debug and repeat the procedure. 

PRX=2000 
BGX 
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WARNING Make sure that the workspace is clear of any obstacles.  In the event of a run-
away condition, the machine may be irreversibly damaged. 

 
7) Display the current position and position error.  TP; TE. 

8) Command the X-axis to make a negative move.  If the axis runs away debug and repeat the procedure. 

PRX=-2000 
BGX 

9) Display the current position and position error. TP; TE. 

10) Repeat step 6 through 9 for the Y, Z and W axes. 
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Maintenance 
Schedule 

Table 8 – Preventive Maintenance Schedule 

Type Of Service 

Service Area Every Shift Weekly Monthly Quarterly 
Dispensing 
Equipment 

Check all fluid 
pressures and 
dispense weights. 

Check for material 
buildup on fixtures 
and locating 
surfaces. 

Check for any leaks 
around compression 
fittings.  Retighten 
or replace if 
needed. 

Inspect the fluid 
delivery lines for 
excessive wear. 

Check the inline 
material filter for 
clogging. 

Electro-
mechanical 
components 

 Check motors for 
overheating and 
smooth operation. 

Check for any 
chaffing of wires, 
pneumatic lines or 
material lines. 

Inspect enclosure 
air filter, clean with 
warm soapy water 
as needed.  Air dry 
before reinstalling. 
(PVA250™, 
PVA750™ models 
only.) 

Grease the ball 
screw slides with 
Lithium Grease 
(JIS Type 2). 

Inspect all moving 
cables for 
excessive wear. 

Conveyor 
System 

Clean conveyor 
belts. 

Check for material 
and dust buildup on 
the sensors. 

Check the 
conveyor belts 
for wear. 

 

Part-in-Place 
Sensors 

Clean with warm 
water, a mild 
solvent (like dish 
soap) and a soft 
cloth.  DO NOT 
use moderate or 
harsh solvents, 
such as Isopropyl 
Alcohol, Acetone, 
OS120, etc. 

   

Pneumatics  Check for proper 
operation.  Drain 

 Check the slides 
for wear and 
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Type Of Service 

Service Area Every Shift Weekly Monthly Quarterly 
any accumulated 
water from the main 
Filter/Regulator. 

smooth operation. 

Dispensing / 
Spraying 
Equipment 

 Lubricate packing 
as per the 
manufacturers 
recommendations. 

  

Clean Purge 
Cups 

Daily    

Clean Valve 
Tips 

Daily    
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Procedures 

Ball Screw Slides 
The slides should be greased via the fitting on the carriage every 100KM or approximately once a month. 
Clean any buildup on the ballscrew and seals.  The manufacturer recommends using a lithium type soap 
base grease (JIS Type 2).  Not all models have slide with grease fitting.  If a slide does not have a grease 
fitting, simply apply a small amount of grease to the slide, then work the slide back and forth. 

Inspection 
The cables in the flexible cable carrier should be checked for excessive wear.  Any worn cables should be 
replaced.  Check for loose screws in the top frame and end effector. 

Conveyor Belt Replacement 

1) Lockout the power and air supplies. 

2) Remove the dust cover plate.  The dust cover plate is located near the conveyor motor on the inside of 
the conveyor. 

3) Remove the old conveyor belt from the pulley wheels. 

4) Clean the conveyor rails where the belt rides. 

5) Install the new conveyor belt.  Start by placing the belt on the pulley wheels farthest from the motor.  
NOTE: Make sure that there are no twists in the belt. 

6) Place the belt around the large pulley wheel, then around the remaining wheels. 

7) Rotate the pulley wheels several turns by hand.  This ensures that the belt is correctly seated. 

8) Replace the cover plate. 

Valves 
Refer to the Cut Sheets section of the Operating Guide for information about the dispensing / spraying 
equipment. 

Servicing the Inline Material Filter 
Machines dispensing or spraying low viscosity materials (such as conformal coating) may have an inline 
stainless steel filter on the pressure vessel.  If material flow appears restricted, the filter element could be 
clogged.  All parts of the filter are stainless steel and can be cleaned several times before replacing.  Follow 
these steps to clean or replace the filter:   

1) Turn off air supply pressure to the pressure vessel. 

2) Turn off the material valve on the vessel. 

3) Using two large adjustable wrenches, separate the two sections of the filter. 

4) Remove the stainless steel filter element, noting the proper orientation. 

5) Clean or replace the filter as necessary. 
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6) Reassemble the filter and pressurize the system.  It may be necessary to purge any trapped air from the 
system. 

Exhaust Fan Setup 
1) Turn power OFF. 

2) Open the electrical enclosure. 

3) Set the overload relay current for 1.0 * FLA for the motor.  The FLA is shown on the motor 
nameplate. 

4) Set the reset button to Manual. 

5) Restart the machine. 

Pressure Differential Switch Setup 
NOTE: The flow velocities referred to be only valid for a 5” duct diameter!!!! 
1) Turn on the exhaust at 100% speed.  

2) Check operation of the pressure switch input.  The input should be ON with the exhaust at 100% 
speed. 

3) Turn off the exhaust.  Make sure the pressure switch input turns OFF. 

4) Restrict the outlet of the exhaust until the airflow velocity is between 1800-2000 ft/min (200-220 cfm) 
at the exhaust flange screen. 

5) Verify that the exhaust pressure switch input is still ON.  If it is not, turn the adjustment screw 
counterclockwise until the input just turns ON. 

6) Turn off the exhaust.  Make sure the pressure switch turns OFF. 

7) Turn on the exhaust.  Make sure the pressure switch input turns ON.  If not, turn the adjustment screw 
counterclockwise again until the input turns ON.  Verify that the input turns OFF when the exhaust is 
turned off. 

8) Restrict the outlet of the exhaust until the airflow velocity is between 1400-1600 ft/min (155-175 cfm) 
at the exhaust flange screen. 

9) Verify that the pressure switch input stays OFF at this airflow velocity.  If the input stays ON, turn the 
adjustment screw clockwise SLOWLY until the input turns OFF.  If an adjustment is made, re-check 
the input at the airflow velocity used in step 4.  The input should still turn ON at an airflow velocity 
within the range used in step 4. 

10) Cycle the exhaust off and back on again.  Verify that the pressure switch input stays OFF for an 
airflow velocity within the range used in step 8. 
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Part Replacement 
Ordering Parts 
All customers can order parts by contacting Customer Service Support. Your customer service 
representative can help take your order. When ordering spare parts, be prepare to provide the following 
information: 

• Your Company Name 
• Billing Address 
• Shipping Address 
• Serial Number of the Workcell (found on the back of the equipment) 
• Part number or description 
• Quantity 
• Purchase Order or Credit card information 
• Shipping Instructions 

 
TIP  
  Keeping an extra set of frequently used spare parts can help reduce down time. 
 
 

Return Material Authorization (RMA) 
Obtain a Return Material Authorization (RMA) from Precision Valve & Automation, Inc. by calling PVA 
Tech Support. 

Training 
Because of the replacement parts it requires safety and familiarity with the equipment, Precision Valve & 
Automation, Inc. offers Training Certificates to Customer technicians, contact PVA. 

Warranty 
Contact Precision Valve & Automation, Inc. for any warranty issue related with spare parts. 

Shipping 
When you ordering parts, specify which carrier you prefer to use. Precision Valve & Automation, Inc. will 
determine the best shipping if no instructions are received. 
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Appendix A – Definitions 
Auto Cycle – Machine state where cycles are running. 

Auto Purge – A machine function that automatically purges material after a predefined period of time or 
during solvent cups procedures. 

Calibration Position – The location in the workspace where the X, Y, Z and W locations for the needle(s) 
is normalized. 

Cycle Stop – Machine state where no action is occurring and the machine is at the standby position. 

Depress – Press and hold for the duration of the operation. 

Dispense / Spray Path – A continuous motion profile.  The valve is on (dispensing / spraying) during the 
entire motion profile.  Also known as a Path or Motion Sequence. 

DMC – Language used to program the motion controller in the workcell. 

End Effector – The dispense / spray head assembly.  The end effector is moved by the axes. 

Function Keys – A set of eight membrain buttons located on the OIT used to select various modes and 
functions of the workcell. 

Head – Dispensing / spraying valve. 

Home Position – The (0, 0, 0, 0) location of the workspace.  This position is determined by the location of 
the home sensors.  It is NOT the same as the Standby Position. 

Jog – Moving any combination of axes continuously at a set rate of speed until commanded to stop. 

Light Tower – The light tower consists of three stacked lights, red, amber and green (top to bottom).  It is 
used to indicate the status of the machine. 

Main program file – Text file containing the code that runs the workcell during normal operations. 

Motion Sequence – A continuous motion profile.  The valve is on (dispensing) during the entire motion 
profile.  Also known as a Dispense / Spray Path or Path. 

OIT – Operator Interface terminal. 

Path – A continuous motion profile.  The valve is on (dispensing / spraying) during the entire motion 
profile.  Also known as a Dispense / Spray Path or Motion Sequence. 

PathMaster® – Windows® programming software.  Used to create, maintain and download program files 
for the workcell. 

Press – Press and release. 

Program – A collection (or series) of motion sequences.  

Project – File containing the code for one or more programs (typically 30 programs). 
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Purge Position – The location in the workspace where the head moves to perform all auto purge 
operations. 

PVA – Precision Valve & Automation, Inc.  

Solvent Cups – Reservoirs containing a compatible solvent used to maintain the dispense / spray valves 
when the workcell is not processing product. 

Solvent Position -  The location in the workspace where the head moves to rest in a solvent solution to 
maintain the dispense / spray valves when the workcell is not processing product. 

Standby Position – The rest position for the end effector.  The machine moves here after homing and after 
each cycle.  This position is usually located near the start point for the program(s).  It is NOT the same as 
the Home Position. 

Terminal – A program used as a communication link between the controller and operator. 

Teach – A process by which the workcell registers its current gantry location with PathMaster® to create a 
motion sequence. 

Workcell – A model PVA250™, PVA250E™, PVA350™, PVA550™, PVA650™, PVA750™, 
PVA1000™, PVA2000™, PVA2000C™ or PVA3000™ automated system.           
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Appendix B – Serial Communication 
Serial Communication 

Overview 
The workcell communicates with a computer using the EIA RS-232C standard.  The computer is the Data 
Terminal Equipment (DTE Device) and the controller is the Data Communications Equipment (DCE 
Device).  The tables below give a brief overview of the connections required to communicate between 
DTE and DCE devices. 

WARNING The computer must be at the same ground potential as the machine.  Damage to 
the machine or computer may result if the ground potentials are different. Use the workcell service 
outlet for computer power if provided. 

9 Pin Serial Connector 
Table 9 describes the pinout for standard serial ports found on most portable computers. 

Table 9 – DTE 9 Pin Serial Connector 

Pin Description 
1 Carrier Detect (CD) 
2 Received Data (RD) 
3 Transmitted Data (TD) 
4 Data Terminal Ready (DTR) 
5 Signal Ground 
6 Data Set Ready (DSR) 
7 Request to Send (RTS) 
8 Clear to Send (CTS) 
9 Ring Indicator (RI) 

 

25 Pin Serial Connector 
Table 10 describes the pinout for standard serial ports found on most desktop computers. 

Table 10 – DTE 25 Pin Serial Connector 

Pin Description 
1 Protective Ground 
2 Transmitted Data (TD) 
3 Received Data (RD) 
4 Request to Send (RTS) 
5 Clear to Send (CTS) 
6 Data Set Ready (DSR) 
7 Signal Ground 
8 Carrier Detect (CD) 
9 +Voltage 

10 -Voltage 
11 Unused 
12 Secondary CD 
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13 Secondary CTS 
14 Secondary TD 
15 DCE Transmitter Clock 
16 Secondary RD 
17 Receiver Signal Clock 
18 Unused 
19 Secondary RTS 
20 Data Terminal Ready (DTR) 
21 Signal Quality Detector 
22 Ring Indicator (RI) 
23 Data Signal Rate Selector 
24 DTE Transmitter Clock 
25 Unused 

 

Computer 9 Pin to workcell Programming Port 
For standard communication between a computer and a workcell. 

Table 11 – Cable for Computer DB9 to workcell 

Comp 
DTE 
DB9 

workcell 
DCE 

DM9F 
1 1 
2 2 
3 3 
4 4 
5 5 

Computer 25 Pin to workcell Programming Port 
For standard communication between a computer and a workcell. 

Table 12 – Cable for Computer DB25 to workcell 

Comp 
DTE 
DB9 

workcell 
DCE 

DM9F 
1 5 
2 3 
3 2 
4 1 
5 4 
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Appendix C – Error Codes 
DMC Error Codes 

Table 13 – DMC Error Codes 

ID Description 
1 Unrecognized command 
2 Command only valid from program 
3 Command not valid in program 
4 Operand error 
5 Input buffer full 
6 Number out of range 
7 Command not valid while running 
8 Command not valid while not running 
9 Variable error 

10 Empty program line or undefined label 
11 Invalid label or line number 
12 Subroutine more than 8 deep 
13 JG only valid when running in jog mode 
14 EEPROM check sum error 
15 EEPROM checkwrite error 
16 IP incorrect sign during position move or IP given during forced deceleration 
17 ED, BN and DL not valid while program running 
18 Command not valid when contouring 
19 Application strand already executing 
20 Begin not valid with motor off 
21 Begin not valid while running 
22 Begin not possible due to Limit Switch 
24 Begin not valid because no sequence defined 
25 Variable not given in IN command 
28 S operand not valid 
29 Not valid during coordinated move 
30 Sequence segment too short 
31 Total move distance in a sequence > 2 billion 
32 More than 511 segments in a sequence 
41 Contouring record range error 
42 Contour data being sent too slowly 
46 Gear axis both master and follower 
47 Gearing and coordinated moves cannot run simultaneously 
50 Not enough fields 
51 Question mark not valid 
52 Missing " or string too long 
53 Error in {} 
54 Question mark part of string 
55 Missing [ or [] 
56 Array index invalid or out of range 
57 Bad function or array 
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ID Description 
58 Unrecognized command in a command response (i.e._GNX) 
59 Mismatched parentheses 
60 Download error - line too long or too many lines 
61 Duplicate or bad label 
62 Too many labels 
65 IN command must have a comma 
66 Array space full 
67 Too many arrays or variables 
71 IN only valid in task #0 
80 Record mode already running 
81 No array or source specified 
82 Undefined array 
83 Not a valid number 
84 Too many elements 
90 Only X Y Z W valid operand 
95 TM too large for stepper pulse 
96 SM jumper needs to be installed for stepper motor operation 

100 Not valid when running ECAM 
101 Improper index into ET (must be 0-256) 
102 No master axis defined for ECAM 
103 Master axis modulus greater than 256*EP value 
104 Not valid when axis performing ECAM 
105 EB1 command must be given first 
118 Controller has GL1600 not GL1800 
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Appendix D – Open Loop Velocity Settings 
Maximum Velocity settings 
Due to the “open loop” nature of the stepper driven systems, we must set a maximum speed for each axis 
that must not be exceeded.  Unlike our “closed loop” servo systems which generate a position error if the 
user attempts to run the motors faster than they are capable of moving, an “open loop” loop system will 
simply lose position and keep going.  The maximum speeds for each system are listed below: 
 

Table 14 – PVA250™ Velocity Limits 

PVA250™ 
Axis Max User Speed Max Burn in speed Max Acceleration Max Deceleration 

X-Axis 60000 cnts/sec 66000 cnts/sec 300000 cnts/sec2 300000 cnts/sec2

Y-Axis 60000 cnts/sec 66000 cnts/sec 300000 cnts/sec2 300000 cnts/sec2

Z-Axis 6000 cnts/sec 6500 cnts/sec 30000 cnts/sec2 30000 cnts/sec2

 

Table 15 – PVA750™, PVA2000C™ Velocity Limits 

PVA750™, PVA2000C™ 
Axis Max User Speed Max Burn in speed Max Acceleration Max Deceleration 

X-Axis 125000 cnts/sec 134000 cnts/sec 500000 cnts/sec2 500000 cnts/sec2

Y-Axis 125000 cnts/sec 134000 cnts/sec 500000 cnts/sec2 500000 cnts/sec2

Z-Axis 6000 cnts/sec 6500 cnts/sec 50000 cnts/sec2 50000 cnts/sec2
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Appendix E – Wiring Schematic Legend 
Wire Numbering 

Table 16 – Wire Numbering 

Type ID Example Description 
DC Control 400 - 599 400  
DC Supply 300 - 399 300  
AC Control 200 - 299 200  
AC Control Power 100 - 199 100  
AC Supply Power nLm 1L2 Segment 1 of AC Supply Phase 2 
Ground GND GND  
Neutral NEU NEU  
AC or DC Motor nTm 1T2 Motor 1, phase 2 
Inputs n1mm 1101 Module 1, Input 01 
Outputs n0mm 2001 Module 2, Output 02 
Connector Jnnn/mm J100/5 Connector 100, pin 5 

Wire Color Code 
Table 17 – Wire Color Code 

NOTE:  This color code does not apply to multi-conductor cables. 

Type Color Example 
DC (<150 V) BLUE 0 Vdc, 80 Vdc 
DC (>150 V) BLACK 200 Vdc 
AC (<150 V) RED 120 Vac 
AC (>150 V) BLACK 208 Vac, 480 Vac 
Neutral WHITE  
Ground GREEN or GREEN with YELLOW  
Remote YELLOW Remote control circuit 
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Warnings, Cautions, and Notes 
Certain warning symbols are affixed to the machine and correspond to notations in this manual.  Before 
operating the Dispensing System, identify these warning labels and read the notices described below.  Not 
all labels may be used on any specific system. 

 

 

Always wear approved safety glasses when operating or working near the 
Dispensing System.  

 

6040 

 

In situations where inattention could cause either personal injury or 
damage to equipment a warning notice is used. 

 
6014 

 

Do not smoke near the Dispensing System. Always have a fire 
extinguisher available for emergency use.  

 

6019 

 

Before operating the system, read and understand the manuals provided 
with the unit. 

 
6017 

 

Before performing any repairs or maintenance to the system, turn off 
power and lock out the power disconnect switch. 

 
6011 

 

Never place hands or tools in areas designated by this symbol when the 
machine is in operation.  A dangerous condition may exist. 

 
6008 



 

 

Warning notices are used to emphasize that hazardous voltages, current, 
temperatures, or other conditions that could case personal injury exist in 
this equipment or may be associated with its use.  Only qualified 
personnel should enter areas designated with this symbol. 

6010 

 

Before performing any repairs or maintenance to the system, read and 
understand the manuals provided with the unit.  Service should only be 
performed by a qualified individual. 

 
6018 

 

Exercise caution when pressurized vessels are present.  Identify and 
repair any leaks immediately.  Always wear appropriate safety equipment 
when working with pressurized vessels or vessels containing chemicals. 

 
6054 

 

Laser light source present. Do not stare directly into the beam.  Do not 
use in the presence of highly reflective surfaces. 

 
6003 

 

Pinch hazard from moving parts. Avoid contact. 

 
1012 

 

Shear hazard from moving parts.  Avoid contact. 

 
1099 

 

Hot surface.  Avoid contact. 

 
6043 

 

Do not remove protective guarding. 

 
6060 

 



This document is based on information available at the time of its publication.  While efforts have been 
made to be accurate, the information contained herein does not purport to cover all details or variations in 
hardware or software, nor to provide for every possible contingency in connection with installation, 
operation, or maintenance.  Features may be described herein which are not present in all hardware and 
software systems.  Precision Valve & Automation, Inc. assumes no obligation of notice to holders of this 
document with respect to changes subsequently made. 

Precision Valve & Automation, Inc. makes no representation or warranty, expressed, implied, or statutory 
with respect to, and assumes no responsibility for the accuracy, completeness, sufficiency, or usefulness of 
the information contained herein.  No warranties of merchantability or fitness for purpose shall apply. 

This document, including the information contained herein, is the property of Precision Valve & 
Automation, Inc. and is considered confidential and proprietary information.  It is delivered on the 
express condition that it not be used, disclosed, or reproduced in whole or in part, for any reason without 
prior written consent of Precision Valve & Automation, Inc. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Copyright © 2003 Precision Valve & Automation, Inc. 
All Rights Reserved.
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Preface 
Notice & Disclaimer 
This manual applies to one of the following automated workcells produced by Precision Valve & 
Automation, Inc.: 

•  PVA250™ 
•  PVA550™ 
•  PVA750™ 
•  PVA1000™ 
•  PVA2000™ 
•  PVA200C™ 
•  PVA3000™ 

All machines are referenced throughout the manual as the Dispensing System or Workcell.  This manual 
provides information and functionality descriptions covering all the common options and configurations for 
a Dispensing System.  The particular machine associated with this manual may not contain all items or may 
have additions.  If the manual refers to an option that was not purchased, ignore that section.  If options 
exist on the machine not mentioned in this manual, please consult the Optional Equipment section of the 
Operating Guide for more information on these additions. 

Revisions to This Manual 
The following list describes the major revisions in this manual (Rev. H 6/03) as compared to previous 
manuals: 

•  Rewrite for PathMaster® version 2.05, including subroutine information. 

•  Update for PathMaster® version 2.3. 6/23/03 TMB 

Content of This Manual 
Definitions. Definitions for commonly used terms. 

Notices and Warning.  Basic safety practices are reviewed. 

Getting Started.  Instructions on establishing communication with the Dispensing System and installing the 
PathMaster® software. 

Working with Materials.  Overview on the basics of liquid dispensing. 

Beginning Programming.  Prerequisite information for using PathMaster®. 

PathMaster® Overview.  Basic description of features and tools of PathMaster® software. 

Using PathMaster®.  Detailed manual on using the PathMaster® software. 

DMC Error Code.  A list of error codes that may be encountered while using the Dispensing System. 
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Definitions 
Auto Cycle – Machine state where cycles are running. 

Auto Purge – A machine function that automatically purges material after a predefined period of time. 

Calibration Position – The location in the workspace where the X, Y, Z and W locations for the needle(s) 
is normalized. 

Cycle Stop – Machine state where no action is occurring and the machine is at the standby position. 

Depress – Press and hold for the duration of the operation. 

Dispense Path – A continuous motion profile.  The valve is on (dispensing or spraying) during the entire 
motion profile.  Also known as a Path or Motion Sequence. 

DMC – Language used to program the motion controller in the Dispensing System. 

End Effector – The dispense head assembly.  The end effector is moved by the axes. 

Head – Dispensing, or spray valve (or any other part processing device). 

Home Position – The (0, 0, 0, 0) location of the workspace.  This position is determined by the location of 
the home sensors.  It is NOT the same as the Standby Position. 

Jog – One or more axes are command to traverse continuously at a specified speed until commanded to 
stop. 

Light Tower – The light tower consists of three stacked lights, red, amber and green (top to bottom).  It is 
used to indicate the status of the machine. 

Main program file – Text file containing the code that runs the Dispensing System during normal 
operations. 

Motion Sequence – A continuous motion profile.  The valve is on (dispensing) during the entire motion 
profile.  Also known as a Dispense Path, Coating Path or Path. 

Offline Programming -  A manor of programming Path Programs without being connected to the 
Dispensing System.  Known as FastPath™. 

Path – A continuous motion profile.  The valve is on (dispensing) during the entire motion profile.  Also 
known as a Dispense Path or Motion Sequence. 

PathMaster® – Windows® programming software.  Used to create, maintain and download program files 
for the Dispensing System. 

Press – Press and release. 

Program – A collection (or series) of motion sequences.  

Project – File containing the code for one or more programs. 

Purge Position – The location in the workspace where the head moves to perform all auto purge 
operations. 

PVA – Precision Valve & Automation, Inc. Precision Valve & Automation. 

Solvent Cups – A container filled with an agent designed to prevent the spray and dispensing valves from 
clogging when idle for a specified period of time.  Also known as Solvent Rest. 
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Solvent Purge – An Auto Purge performed after the valves move from the solvent cups prior to processing 
product. 

Standby Position – The rest position for the end effector.  The machine moves here after homing and after 
each cycle.  This position is usually located near the start point for the program(s).  It is NOT the same as 
the Home Position. 

Terminal – A program used as a communication link between the controller and operator. 

WSDK-1500 – Windows® Servo Design Kit 1500.  This software is used to setup and tune the servo 
system.  
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Notices and Warnings 
•  Safety glasses, gloves, and long sleeved clothing are necessary precautions when working with 

automated industrial equipment. 

•  Read and understand all operating manuals before using this equipment. 

•  Do not disable the safety features of the machine. 

•  Lock-out and tag the air and power supplies before servicing or cleaning any part of this equipment. 

•  Do not remove any hose, either air or fluid, without relieving the pressure. 

•  Do not replace any hose with a hose of inadequate pressure rating. 

•  Use only replacement parts recommended or supplied by the manufacturer. 

•  Always remain clear of all moving parts when the system is in operation. 
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Getting Started 
Necessary Skills 
The Dispensing System operator must be familiar with Windows® and its most common features.  This 
includes Notepad (or a similar text editing program), Explorer (or File Manager) and how to cut-and-paste 
information from one place to another.  It is STRONGLY recommended that personnel be thoroughly 
versed in these subjects before attempting to program the machine. 

Hardware & Software Requirements 
PathMaster® requires a Pentium processor and at least 32 MB of RAM for Windows® 95, 98, NT, 2000, 
me, or XP operating systems. 

Installing PathMaster® 
To install PathMaster®, first close any applications that may be open.  If the install is done via 3½” disks,  
take disk #1 of the PathMaster® installation disks and place it in the floppy drive, making sure it is secure.  
Run setup.exe and follow the instructions on the screen.  For CD-ROM installations, insert the CD into the 
CD drive.  Run setup.exe on the CD drive and follow the instructions on the screen. 

NOTE:  PVA recommends installing the software in its default directory (c:\Program Files\PVA). 

Tutorials 
In the tutorials directory of the PathMaster® CD-ROM are a number of audio/visual tutorials.  These can be 
accessed via the Help→Contents option in PathMaster® or the pathmaster.hlp file.   

NOTE:  If the computer in use does not have a sound card or the card is not installed properly, the audio 
portion of the tutorials will not function.  

Communications 
The Dispensing System communicates with a computer using the EIA RS-232C standard.  The computer is 
the Data Terminal Equipment (DTE Device) and the controller is the Data Communications Equipment 
(DCE Device).  A programming port is located on the front of the machine.  The controller baud rate and 
handshaking function are set with dip switches on the controller inside the Dispensing System enclosure.  
The settings for the controller and the computer must be the same. 

WARNING The computer must be at the same ground potential as the machine.  Damage to 
the machine or computer may result if the ground potentials are different.  Use the Dispensing 
System service outlet for computer power. 

DMC-1500 Dip Switch Settings 
The main RS-232 port on the DMC-1500 controller must be configured as follows to communicate with the 
PathMaster® software. 

Table 1 – DMC-1500 Dip Switch Settings for PathMaster® 

Switch Position Description 
MRST OFF Master Reset Switch 
1200 OFF Baud rate 
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9600 ON Baud rate 
19200 OFF Baud rate 
HSHK ON Hardware Handshaking Switch 

 

NOTE:  If hardware handshaking is enabled, and the program uses the message command and a 
computer is not attached to the Main RS-232 port, the controller eventually halts.  A computer must be 
attached to the controller when handshaking is enabled and message commands are used. 

Computer Settings 
The following are the correct settings to communicate with the motion controller. PathMaster® 
automatically sets the data bits, parity and stop bits. 

Table 2 – Communication Program Settings 

Option Setting 
Baud rate 9600 
Data bits 8 

Parity none 
Stop bits 1 

Uninstalling PathMaster® 
To uninstall the software go to Windows® Control Panel and select Add/Remove Programs.  The 
Install/Uninstall screen appears.  Scroll down and highlight PathMaster.  Then click on the Add/Remove 
button. PathMaster® is removed by Windows®. 

As Windows® removes all the components associated with PathMaster®, it may query the operator 
concerning shared files.  If in doubt, Precision Valve & Automation, Inc. recommends NOT deleting any 
shared files.  Precision Valve & Automation, Inc. assumes no responsibility for any difficulties arising from 
the deletion of shared files during the uninstall procedure of PathMaster®. 

NOTE:  This process completely eliminates the PathMaster® software and all its components, including 
registry entries. 

Multiple Dispensing System Issues 
Unless a multiple machine cross-programming system was purchased with the Dispensing System, 
Precision Valve & Automation, Inc. Precision Valve & Automation STRONGLY recommends that 
customers not attempt to run programs developed with one Dispensing System on a second Dispensing 
System.  While machines may appear similar, minor differences in the homing sequence, pneumatic 
actuators, etc. can be sufficient to cause an externally-developed program to damage a Dispensing System.  
Precision Valve & Automation, Inc. is not responsible for damages incurred in any such attempt. 

Year 2000 Compliance 
PathMaster® is compliant with and comprehends the year 2000 century date change. PathMaster® will not 
have any operational impediments, malfunction, cease to perform, generate incorrect or ambiguous data 
and/or produce incorrect or ambiguous results with respect to same-century and multi-century formulas, 
functions, date values and date-data interfaces. 
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If Something Goes Wrong . . .  
Some problems encountered when using the Dispensing System are easy to identify and solve.  Others 
require more extensive help.  It is best to program in small increments, so problems appear quickly and can 
be diagnosed easily.  Save work frequently during the programming process. 

For non-immediate problems or to report suggestions, please email pathmaster@pva.net. 

Calling Technical Support 
The technical support staff is always available to help solve any problems.  The phone number is (518) 
371-2684.  To assist in the troubleshooting process, it is best if as many of the following items are 
addressed before calling for help: 

1) Note the serial number of the Dispensing System.  The serial number can be found on the legend plate 
located on the front of the electrical enclosure. 

2) Record all the information on the OIT or PC when the error occurred. 

3) If the error was not serious, attempt to repeat the error.  If the error does not repeat, the problem may 
have been operator generated. 

4) Use a terminal screen to communicate with the controller.  Most troubleshooting requires issuing 
commands directly to the controller. 

5) A hard copy or email of the program in question may be requested by PVA.  Please be prepared to 
send it.  The PVA fax number is (518) 371-2688, or the customer service representative will provide 
an email address, if all parties are email capable. 
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Working with Materials 
Overview 
The Dispensing System workcell is designed to operate with many different materials in a variety of 
applications.  Learning to use and program with these materials is both an art and a science.  There are no 
concrete rules for an operator to follow; the best method for establishing settings for the system is trial-and-
error.  Once acceptable parameters are found it is easy to maintain those parameters over time. 

System Components 
Each part of the material delivery system must be adjusted and optimized for the selected material.  In 
general, it is best to approach the problems in the order listed below. 

Material Feed 
Usually, material is moved through the system by one of two methods, either a pump or a pressure vessel.  
For either method, the operator’s first task is to consult the manufacturer’s material specifications and 
determine the appropriate settings for the material delivery system.  If a pump is used on the system, the 
separate pump manual should be thoroughly read and understood to determine the best settings for the 
material.  For a pressure vessel, if the pressure is too high the valve output will be excessive and 
inconsistent in flow and air may be forced into the material.  Too little pressure provides insufficient 
output. 

Dispense (Needle) Valve 
The only direct adjustment for the needle valve is the stroke.  Turning the knurled knob on the top of the 
valve counter-clockwise increases flow through the valve.  A fine steady stream of material is all that is 
needed.  Once a satisfactory setting is found, secure the stroke position with the locking nut.   Once the 
locking nut is secure verify the valve flow rate before continuing.  

Needle Selection 
Experiment with different needle sizes to determine the best size for the system.  If the needle is too large a 
drip develops at the end of the needle.  To small a needle yields insufficient flow. 

Spray Valve 
Two adjustments are available for the spray valve:  Valve stroke and atomizing air.  The stroke controls the 
flow of material through the valve.  Turning the knurled knob on the top of the valve counter-clockwise 
increases flow through the valve.  Atomizing air is controlled by a pressure regulator located on the front of 
the machine.  Turning this clockwise increases the air pressure.  This pressure can only be adjusted while 
the valve is active.  Once satisfactory settings are found for these items, secure the stroke position on the 
valve using the locking nut.  Secure the regulator by pressing the cap or tightening the lock nut.  Once the 
locking nut is secure verify the valve flow rate before continuing.  

When first operating the machine, follow this list of instructions to adjust the spray valve: 

1) Set the atomizing air to 0 P.S.I. 

2) Take off the spray cap. 

3) Turn the stroke down all the way. 

4) Using the purge function in Manual mode, open the stroke to a few drops per second.  It may be 
necessary to cycle the valve on and off while adjusting the stroke. 
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5) Replace the spray cap. 

6) While purging, adjust the atomizing air until the spray is satisfactory.  Test the spray pattern on scrap. 

If the atomizing air is too high, the spray will be misty.  If it is too low, there will be splatter.  Thin, solvent 
based materials usually require as little as 0.5 P.S.I., while some silicones require as much as 15 P.S.I. 

Extended Spray Cap 
This cap is exclusive to the FCS100-ES valve.  It is identified by its small long cylinder nozzle.  This cap 
can reach into tight areas between tall components, were a very defined pattern is required. 

Round Spray Cap 
This provides a circular spray pattern.  It is identified by its lack of external air ports.  It works well for 
solvent based materials or where a smaller, more defined pattern is required. 

Flat Spray Cap 
The spray from this cap is rectangular/oval in shape.  It is identified by the protruding atomizing air ports.  
It works best with non-solvent based materials and provides a wider spray path for increased coverage. 

Programming 
Once the physical parameters are successfully established for the delivery system, they should never be 
altered.  The best method for changing the material output is to alter the program.  In most cases, raising or 
lowering the speed of a dispense path is enough to change the material output to the desired level. 

When programming with the dispense valve, lower the valve so that the end of the needle is close to the 
part surface, but not too close such that varying needle length tolerances will cause the needle to make 
contact with the surface of the product. 

With the spray valve, a good rule of thumb is to start about ¾” (19 mm) above the product surface.  With 
atomizing air, this should produce a spray width approximately ½” to  ¾” (19 mm) wide.  If necessary, 
adjust the spray height so the pattern on the product is consistent and uniform. 
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Beginning Programming 
Overview 
This section provides important information every operator must know before programming the Dispensing 
System.  A thorough understanding is recommended. 

Planning Path Programs 
It is best to plan the path program on paper before starting on the machine.  Break the planned program into 
individual paths and number each path and the points within it, along with which valve is active and what 
pneumatic operations must be performed.  The path numbers and point numbers should correspond to the 
order in which the program proceeds.  This documentation is very useful when debugging programs. 

Breaking the path program into smaller segments is wise and provides three advantages.  First, each 
segment can have different on, off and speed parameters.  Second, the operator can focus on programming 
and debugging one segment at a time.  Third, if one segment of the program must be changed, the 
remaining segments are not affected.  This reduces debugging time and makes the program maintainable. 

When programming, the operator should comment the program as needed to enable anyone to follow the 
logic.  Again, this decreases debugging problems and saves time in the long run. 

NOTE:  If a stop or dwell must be added at one of the points after a path is completed, then the path 
must be broken into two paths or entirely reprogrammed. 

Incorrect Valve Usage 
When programming or operating the Dispensing System, the valves should NEVER be used for moving 
components or boards.  Precision Valve & Automation is not responsible for damages incurred from using 
the valves in an inappropriate manner. 

Inserting Valve Commands into Programs 
Pneumatic positions (head up/down, rotary selection) are not automatically programmed by PathMaster® 
and there is no communication between the Dispensing System and PathMaster® concerning the active 
valve or its pneumatic position.  Therefore, it is the responsibility of the operator to select the appropriate 
valve within PathMaster® and insert the necessary pneumatic commands into the program after a path has 
been completed. 

It is important these commands are not inserted at incorrect locations.  In general, try to follow these rules: 

•  Program each segment with the corresponding valve slide in the down position. 

•  Actuate a valve rotary before lowering a valve slide. 

•  Move the XY(W) axes into position prior to actuating a valve slide or valve rotary.  

•  Insert valve slide down and valve rotary B commands before any segment(s) that require them.   

•  Insert valve slide up and rotary A commands once finished with the valve. 

•  Raise a valve slide before returning a rotary to A. 

•  Insert all the code for each segment after completing it. 

•  If suddenly changing valves, insert a non-dispense move on the Z axis to 0, to allow room for the new 
valve to lower.  (See Inter-Path Movement on page 18 for more detail.) 
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Inter-Path Movement 
When programming the Dispensing System via PathMaster® it is easy to determine the movement, point-
to-point, within a path program via the playback feature.  However, it is more difficult to gauge movement 
between segments.  After completing a segment, the Dispensing System immediately moves the axes to the 
start point of the next segment.  If there are obstacles in the way, the machine does not know this, since this 
route was not tested and programmed intentionally. 

There are different ways to combat this problem.  The best solution is to follow the recommended 
procedure and map out the path program to allow for direct movements between segments.  If that was not 
done, or obstacles cannot be avoided, then the operator should insert ‘safety’ moves of the Z axis to avoid 
inadvertently hitting anything.  This is accomplished by programming a ‘Z only’ move, with the Z-axis 
target set to 0.  

It is ultimately the operator’s responsibility to ensure no combination or sequence of path segments are 
harmful to the machine or any product the operator is running. 

Main Program Modifications 
Sometimes it is necessary to make changes in the main program that runs the Dispensing System.  Usually 
it involves setting up points for the machine to use.  If the operator must do this, it is imperative to 
download the corrected main file properly to avoid any problems.  Open the Main program using a text 
editor, such as Windows® Notepad or Winpad.   

Common Main Program Changes 
There are a few sets of points that commonly need changing:  Standby position, purge position, solvent cup 
position, and calibration position.  In the main program these settings are located in the Machine Specific 
Information section (near the end of the file), an example of which is shown below: 

REM !!!! Machine-Specific Information !!!!
#IMACH;MT 1,1,1,1
CE 0,0,0,0;FSTX=20000;SLWX=10000;FSTY=20000;SLWY=10000
FSTZ=10000;SLWZ=5000;FSTW=10000;SLWW=5000
KNHEAD=3;A_HEAD[1]="FCS100";R_HEAD[1]=0
A_HEAD[2]="FC100 ";R_HEAD[2]=1
A_HEAD[3]="DISPSE";R_HEAD[3]=1
PT_APG[0]=80000;PT_APG[1]=65000;PT_APG[2]=0;PT_APG[3]=3000
PT_SOL[0]=80000;PT_SOL[1]=65000;PT_SOL[2]=0;PT_SOL[3]=3000
PT_CAL[0]=15000;PT_CAL[1]=15000;PT_CAL[2]=500;PT_CAL[3]=2000
PT_SBY[0]=25000;PT_SBY[1]=25000;PT_SBY[2]=250;PT_SBY[3]=3500
AP_EN=0;AP_LEN=2000;AP_TIME=30000;PNTO=4000;LT_EN=1;AC_TMR=1
SLP_TM=30000;SO_EN=0;LLA_EN=0;LLB_EN=0
#TUNE;AC*=325000;DC*=300000;SP*=120000;VA*=70000;VD*=70000
BL -4000,-4000,-1000,-1000
FL 83000,85000,15000,30000;TL*=9.9999
KD 67.99,82.43,76.09,50.00
KP 5.66,6.75,8.38,5.00
KI 0.25,0.19,0.34,0.50;EN
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The following tables display the command variables that an operator may wish to change. 

Table 3 – Coordinate System Locations 

 Axis 
Locations X Y Z W 

Auto Purge Location PT_APG[0] PT_APG[1] PT_APG[2] PT_APG[3] 

Solvent Cup Location PT_SOL[0] PT_SOL[1] PT_SOL[2] PT_SOL[3] 

Calibration Location PT_CAL[0] PT_CAL[1] PT_CAL[2] PT_CAL[3] 

Standby Location PT_SBY[0] PT_SBY[1] PT_SBY[2] PT_SBY[3] 

Table 4 – Variable Explanations 

Variable Explanation 
AP_EN Default value for auto purge.  1=on, 0=off. 
AP_LEN Length of auto purge, in milliseconds. 
AP_TIME Time between auto purges, in millesends. 
SLP_TM Sleep timer value for solvent rest, in millesends. 
SO_EN Solvent rest enable / disable.  1=enable, 0=disable. 
  

 
Once Main program modifications have been made, the new program must be downloaded to the controller 
using the PathMaster® Download -> Main function. 
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PathMaster® Overview 
General 
Precision Valve & Automation, Inc. has developed a Windows® application to facilitate the development, 
maintenance and execution of programs for the Dispensing System. PathMaster® combines the ease of use 
in typical Windows® applications with the specific functionality necessary for programming the Dispensing 
System. 

PathMaster® Window 
 

 

 

Upper Status Bar 

 

The upper status bar displays the active machine configuration, current project file and current path 
program.  The current path program can be changed via the drop-down list box. 

Lower Status Bar 

 

The lower status bar shows the current status of the Dispensing System.  Whether or not, the PC is 
communicating with the Dispensing System is reflected in the ‘Connected’ display.  The ‘Manual’ display 
indicates if the machine is in Manual mode.  The ‘Error’ display reports if the machine is currently in a 

Title Bar 

Upper Status Bar

Main Menu 

Program Table 

Lower Status Bar

Programming 
Toolbar 
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state of error.  The ‘Units’ field is the measurement system in use when programming, and can be altered in 
the Setup section of PathMaster®. 

NOTE: In order to teach path programs online, PathMaster® must be connected, in Manual mode, and 
not in a state of error. 

Main Menu 

File Menu 
•  Machine – Select a machine configuration. 
•  New – Create a new project. 
•  Open – Open an existing project or subroutine. 
•  Close – Close the current project. 
•  Delete – Delete the current project, or current program. 
•  Save – Save the current project. 
•  Save As – Save the current project under a different name. 
•  Print – Print the current program, or print the entire compiled program. 
•  Database – Backup or restore the PathMaster® database. 
•  Import – Import a project, program, or subroutine. 
•  Export – Export a project, program, or subroutine. 
•  Exit – Exit the application. 

Edit Menu  
•  Program  – Edit the program name, auxiliary code, or background image. 
•  Undo Delete – Undo the last Delete operation. 
•  Cut – Remove highlighted path segment(s) and copy to the clipboard. 
•  Copy – Copy highlighted path segment(s) to the clipboard. 
•  Paste – Copy path segment(s) from the clipboard and insert it into the program. 
•  Delete – Delete highlighted path segment(s). 
•  Select All – Select all path segments from the displayed program. 

Teach Menu  
•  Move – Code a move to a specific location. 
•  3D Path – Teach a 3D path segment and specify valve activity. 
•  2D Path – Teach a 2D path segment and specify valve activity. 
•  Dot – Dispense at a defined point for a length of time and specify valve activity. 
•  Area – Teach an “Area” path segment that covers a rectangular shape. 
•  Circle – Teach a circular path segment and specify valve activity. 
•  Arc – Teach an arc path segment and specify valve activity. 
•  FastMask – Teach a FastMask™ path segment (specify keep out areas). 
•  Polyline – Teach a path segment consisting of 2D, circle, and arc path segments 
•  Subroutine – Create a new or insert an existing PathMaster® subroutine. 
•  Dwell – Teach a delay between path segments in seconds. 
•  I/O – Reference inputs or outputs within the program. 
•  Head – Insert valve functions (up/down, rotary, etc.). 
•  Comment – Insert comments into the path program. 
•  DMC Command – Write DMC machine code into the path program. 

Modify Menu 
•  Properties – Modify properties of  selected path segment. 
•  Offset – Apply an offset to any axis for selected path segments, or the entire program. 
•  Speed – Modify speed for selected path segments, or the entire program. 
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•  Valve Parameters – Modify parameters for selected path segments, or the entire program. 
•  Subroutine Call – Change a subroutine call for the selected path segments. 

Run Menu 
•  Selection – Run (playback) the highlighted path segment on the Dispensing System. 
•  Program – Run (playback) the current program on the Dispensing System. 

Download Menu 
•  Project – Download the current project file. 
•  Main – Download the Main operating program for the Dispensing System. 
 
NOTE:  The operator must activate the EMERGENCY STOP button when downloading files to the 
controller! 

Utilities Menu 
•  View FastPath – Open the FastPath™ window for offline programming. 
•  Measure Distance – Calculate the position between two points. 
•  Machine Debugger – An array of tools useful for debugging. 
•  Refresh Communications – Issue an attempt to reestablish communication with the workcell. 
•  Jog Toolbar – Toolbar used to jog the head from PathMaster® 
•  View Tools – Enable programming toolbar. 
•  Path Preview – Graphic view of the selected path segments. 
•  Show Code – Show machine code for selected path segments. 

Setup Menu 
•  Machine Parameters – Setup machine parameters for the current machine profile. 
•  Passwords – Set password for downloading and saving projects. 
 

Help Menu 
•  Contents – PathMaster® online help.  
•  Commands – Online help manual for the Galil DMC-1500 controller.  
•  About – Information about PathMaster®, including release version.  

Right-Click Menu 
Using the right mouse button while highlighting a function accesses this menu. 

Teach  
� Move – Code a move to a specific location. 
� 3D Path – Teach a 3D path segment and specify valve activity. 
� 2D Path – Teach a 2D path segment and specify valve activity. 
� Dot – Dispense at a defined point for a length of time and specify valve activity. 
� Area – Teach an “Area” path segment that covers a rectangular shape. 
� Circle – Teach a circular path segment and specify valve activity. 
� Arc – Teach an arc path segment and specify valve activity. 
� FastMask – Teach a FastMask™ path segment (specify keep out areas). 
� Polyline – Teach an path segment consisting of 2D, circle, and arc path segments 
� Subroutine – Create a new or insert an existing PathMaster® subroutine. 
� Dwell – Teach a delay between path segments in seconds. 
� I/O – Reference inputs or outputs within the program. 
� Head – Insert valve functions (up/down, rotary, etc.). 
� Comment – Insert comments into the program path 
� DMC Command –  Write DMC machine code into the path program. 
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Modify 
� Properties – Modify properties of  selected path segment. 
� Offset – Apply an offset to any axis for selected path segments, or the entire program. 
� Speed – Modify speed for selected path segments, or the entire program. 
� Valve Parameters – Modify parameters for selected path segments, or the entire program. 

Run 
� Selection – Run (playback) the highlighted path segment on the Dispensing System. 
� Program – Run (playback) the current program on the Dispensing System. 

Move To First Point –  Move to the first point of the selected path segment(s). 

Show Code –  Show machine code for selected path segment(s). 

Path Preview – Graphic view of the selected path segment(s). 

Cut – Remove highlighted path segment(s) and copy to the clipboard. 

Copy – Copy highlighted path segment(s) to the clipboard. 

Paste – Copy path segment(s) from the clipboard and insert it into the program. 

Programming Toolbar 
The programming toolbar provides quick access to the most frequently used programming tools. 

 

Programming Tools 
Programming tools are used to create path segments, which make up a path program.  PathMaster® 
contains a variety of useful programming tools which can be used to create 2 dimensional and 3 
dimensional path motion.  Many of the most commonly used tools are located on the toolbar, while the less 
frequently used tools can be accessed from the Teach menu. 

  Comment – Insert comments into the program 

  Move – Code a move to a specific location. 

  2D Path – Teach a 2D path segment and specify valve activity. 

  3D Path – Teach a 3D path segment and specify valve activity. 

  Arc – Teach an arc path segment and specify valve activity. 

  Circle – Teach a circular path segment and specify valve activity. 

  Area – Teach an “Area” path segment that covers a rectangular shape.  

  FastMask – Teach a FastMask™ path segment (specify keep out areas). 

  PolyLine – Teach a path segment consisting of 2D, circle, and arc path segments 

  Dot – Dispense at a defined point for a length of time and specify valve activity. 
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  Head – Insert valve functions (up/down, rotary, etc.).  

  Step Over Program – Step to the previous, or next path segment. 

  Play – Play back the selected path segments. 

  FastPath – Open the FastPath™ window for offline programming. 

PathMaster® Database 

General 
The PathMaster® application utilizes a flexible database structure to store all parameter and program 
information.  The database structure allows for a central storage location for all data, which can easily be 
backed up and restored.  When projects and path programs are saved, the user will save them under a name 
of there choice, however, the name that they give there projects and path programs will not be visible to the 
user as a file on their hard drive.  The project and program names are stored as records in the database 
rather than the conventional file structure used in previous versions of PathMaster®.  Precision Valve & 
Automation strongly recommends that the entire database be backed up before and after any changes are 
made to projects or programs.  Precision Valve & Automation is not responsible for any lost data or 
production time due to improper database backup procedures. 

Multiple Dispensing Systems 
The database structure employs a system, which will allow as many Dispensing System configurations as 
needed.  In a production environment where multiple machines with varying configurations are utilized, a 
single PathMaster® database can use and maintain the configurations for each of these machines. 

Machine Configuration 
Pathmaster® will utilize the default machine configuration on startup unless there are multiple machine 
configurations stored in the database.  If there are multiple machine configurations available, PathMaster® 
will prompt the user to select the machine or machine configuration that they will be using.  

Path Programs 
A path program is a collection of path segments that make up a dispensing or spray program.  Path 
segments are made up of any combination of programming functions.  Each path program can contain a 
unique name of 12 characters or less.  The path program name is displayed on the workcell OIT while 
running product. 

Project Files 
PathMaster® project files can be thought of as a collection of storage bins for up to thirty path programs.  
Each one of these 30 bins can hold one path program.  When a project file is downloaded to the Dispensing 
System, all 30 of the storage bins are downloaded to the workcell controller, even if some are empty.  The 
empty bins simple do nothing if they are selected to run. 
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Using PathMaster® 
Starting PathMaster® 
The first time you run PathMaster® it will need to be configured to run properly with the Dispensing 
System.  To start  the PathMaster® application, locate and double-click the PathMaster® icon.  The Select 
Project dialog box will display.  Click the Create a New Project  radio button and select OK.  An 
information box will appear indicating that no communication settings were found for your controller.  This 
is normal for the initial startup.  Click the OK button to continue. 

Configuring PathMaster® 
Before PathMaster® can be used, it must be configured to suit the machine and machine application.  
Communication parameters must also be configured to allow PathMaster® to interact with the Dispensing 
System. 

Machine Parameters 
The machine parameter form is used to set attributes specific to the software as well as the hardware.  
Machine parameters are unique to the machine profile.  The settings on the machine parameter form apply 
only to the current machine profile.  The current machine profile is displayed in the upper status bar of the 
main PathMaster® window. 
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Dispensing Parameters 
The dispensing parameters are the default parameters for all coordinated path motion.  These parameters 
can be modified within each programming function for each path segment.  

•  Path Acceleration  - Set default acceleration for all coordinated motion. 
•  Path Deceleration – Set default deceleration for all coordinated motion. 
•  Z-Retract – Set default relative z retract for Dot function. 
•  Dot On Dwell  - Set default valve on time for Dot function. 
•  Dot Off Dwell  - Set default valve off time for Dot function. 

Move Parameters 
The move parameters are the default parameters for all independent path motion for each axis of motion. 

•  Move Speed – Set default move speed for all independent path motion. 
•  Move Acceleration – Set default acceleration for all independent path motion. 
•  Move Deceleration – Set default deceleration for all independent path motion. 

Units 
Select the preferred measurement system (encoder counts, millimeters, inches). 

Machine Type 
Configure PathMaster for a two, three, or four axis gantry.  Check the Stepper Motors box if you are 
running PathMaster® on a PVA250™, PVA750™, PVA2000C™, or any other open loop stepper PVA 
Dispensing System. 

Valves 
Name and configure valve heads as they are used throughout the software.  The names are located in the 
Configuration section of the Operating Guide, along with the options present for each valve.  The ‘Enabled’ 
box should be checked for all the valves present on the machine.  ‘Z-Slide’ and ‘Rotary’ should be checked 
if they are installed. 

Valve Parameters 
•  On Delay Wait – The pause after turning the valve on but before starting the path. 
•  Off Delay Wait – The pause after finishing the path and turning the valve off but before moving to the 

next point. 
•  On Delay Distance – Distance the path traveled before turning the valve on. 
•  Off Delay Distance – Distance the path traveled when turning the valve off, before the path finishes. 
•  Speed – Vector speed for any programming function using the corresponding valve. 
•  Valve Height – Distance from the surface of the product to the lowest point of the valve as taught 

using the valve offset function (offline programming only). 
•  Area Spacing  – Distance between runs when executing an Area path. 

Valve Offsets 
Valve Offset is a wizard used to step through the configuration process of setting the offsets between each 
valve and a pointing device.  These offsets are used for offline program, as well as for online programming 
with a pointing device. 

Machine Auxiliary 
The machine auxiliary function is used to hardcode custom software options into the machine software.  
This function is typically preprogrammed by Precision Valve & Automation and provided to the customer 
with specific instruction on how to use it. 
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Communications 
Communications is used to configure the RS232 communication settings between the computer and the 
Dispensing System.  PathMaster® uses control handles to store all communication settings for a machine.  
A control handle can be thought of as a record in a database that has multiple fields in which to store vital 
pieces of information.  The information in the control handles is stored in the Windows® registry.  
PathMaster® can have multiple control handles configured, but can have only one control handle selected 
at a time. 

To configure communications, click the Edit Controller button on the Machine Parameters form.  If a 
message appears indicating that PathMaster® could not find any controllers in the Windows® Registry, 
click OK.  This simply means that no control handles have been configured yet. 

When the Edit Registry window appears, click New Controller.  

 

Select the controller model installed in the Dispensing System from the table below: 

 

 

Use the default Timeout valve for all controllers and Serial for Connection Type.   NOTE: Not all 
controller models require configuration of Connection Type. 

- Click Next - 

PVA Workcell Controller Model
PVA250 DMC-2100 
PVA550 DMC-1500 
PVA750 DMC-2100 
PVA1000 DMC-1500 
PVA2000 DMC-1500 
PVA2000C DMC-2100 
PVA3000 DMC-1500 
All other’s DMC-2100 
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Select the communication port that your PC is using: 

 

 

The Comm. Speed should match the comm. speed set on the controller.  This is set to 9600 by Precision 
Valve & Automation prior to shipping.  

Select hardware handshaking. 

- Click Finish - 

Acknowledge the dialog box stating that the controller has been added.  

•  Control handle properties can be modified by highlighting the controller and clicking Properties. 
•  Multiple control handles can be added. 
•  Control handles can be deleted by clicking the Delete button. 
 
- Click Close - 
 
Once one or more control handles have been created, you must select the control handle that PathMaster® 
will use to communicate with the Dispensing System.  To select a control handle: 

•  Click the Change Controller button on the Machine Parameters form. 
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•  Select the control handle to be used. 
•  Click the OK button. 

Saving Machine Parameters 
Once all machine parameters have been set, click the Save & Close button to save the parameters and return 
to the main PathMaster® window. 

Database Backup and Restoration 
It is extremely important that the PathMaster® database be backed up properly.  Precision Valve & 
Automation strongly recommends that the entire database be backed up (manually) before and after any 
changes are made to projects or programs.  Precision Valve & Automation is not responsible for any lost 
data or production time due to improper database backup procedures. 

Automatic Backup 
PathMaster® will perform an  automatic backup of the entire database each day that PathMaster® is 
executed. PathMaster® utilizes a rolling ten day automatic backup scheme, therefore, backup file will be 
stored for the last ten days that PathMaster® was executed. All automatic backups are stored in the 
Db\Daily sub folder of the PathMaster® application folder.  The default location of these files is 
“c:\program files\pva\pathmaster\db\daily”. 

Manual Backup 
A manual database backup is by far the safest method.  This method requires a conscious effort by the user, 
and therefore, should be part of a their programming procedure.  To perform a manual database backup, 
select the File -> Database -> Backup option from the main menu.  Save the project if prompted to do so. 
When the Backup Files form opens, click the Backup button.   

 

The Save As dialog box opens.  Select a destination and a filename for the backup file (the backup will 
only be 1 file).  The backup file extension will be ‘bck’.  Click the Save button.  The PathMaster® database 
backup is complete. 

NOTE: Additional files can be added 
to the backup by clicking the Add 
button and selecting the file.  This is 
not normally necessary for a 
complete PathMaster® database 
backup. 
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Database Restoration 
To restore the PathMaster® database, select the File -> Database -> Restore option from the main menu.  
You can restore a *.bck (standard backup) or *.abck (automatic backup) file using this option. 

WARNING: Restoring a PathMaster® database will completely overwrite all existing data prior to the 
restore operation.  If you are attempting to restore partial data, a database restore is not the correct 
procedure. 

Once the file dialog box opens, select the location and file you wish to restore.  Click the Open button.  
Once the restore successful message displays, click OK. Restart PathMaster®. 

Important Reminders 
•  Inserting Code – When the operator uses PathMaster® programming functions to insert code, the code 

is placed at the current highlighted location on the screen.  It is the operator’s responsibility to ensure 
the proper area is highlighted to accommodate the new path. 

•  Inserting Valve Commands – Commands to move the heads or valves are NOT automatically 
inserted into PathMaster® the path programs.  If the operator needs a head to change position (up/down, 
rotary) the appropriate command must be inserted manually via the Head programming tool.  Please 
read Inserting Valve Commands into Programs on page 17 for more information on this subject.  

•  Downloading – The operator must activate the EMERGENCY STOP button when downloading files to 
the controller.  

 

Machine Selection 

 

If more than one machine configuration exists in the PathMaster® database, it is necessary to select the 
appropriate machine before programming.  This option presents itself whenever PathMaster® begins and 
there are multiple machine profiles.  Projects are assigned to particular Dispensing Systems, so it is 
necessary, when changing machines, to select a new project. 
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Project Selection 

 

It is necessary to select the appropriate project before programming.  This option presents itself on startup, 
whenever PathMaster® changes the current machine setting or the operator wishes to open a different 
project. 

•  OK – Select the highlighted project as current. 
•  Cancel – Exit this function without making changes. 

 
 
 

Reading a Program 
The PathMaster® program display is arranged in a table format.  Use the chart below to determine the 
purpose of the text that appears in each field. 

COLUMN USE EXAMPLE EXPLANATION 
Command Programmed command. DOT Dot program. 
 NOTE:  A command 

uses all the lines below 
it until another 
command reference 
appears in the 
command column. 

LINE(3D) 3D Line 

Position Coordinates. 4555,3000,760 Cartesian coordinates 
for current point. 

On Valve or I/O on. (1)W.5 Activate head 1, valve 
on time of .5 seconds. 

  (2)D300 Activate head 2, valve 
on distance of 300 
counts. 

  I49 Wait for input 49 to be 
on. 

  O32 Turn on output 32. 
Off Valve or I/O off. W.75 Deactivate the path’s 
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head 1, valve off time of 
.75 seconds. 

  D500 Deactivate the path’s 
head, valve off distance 
of 500 counts. 

  I51 Wait for input 51 to be 
off. 

  O35 Turn off output 35. 
Speed Path speed. 2000 Path speed of 2000 

counts/second. 
Other Varies according to 

path. 
Z=250 Z axis relative move of 

250 counts after 
completing a dot path. 

 

Playback 
Paths can be played back using two methods in addition to downloading and running the entire program via 
the Dispensing System: 

1) Highlight an individual path and select Run→Selection from the drop-down menu or the right-click 
menu. 

2) Play an entire program by selecting Run→Program from the drop-down menu or the right-click menu. 

Before playback begins, the user will be prompted to select a Wet or Dry playback. 

 

Wet playback activates the valve(s) while running the path.  Dry playback does not activate the valve(s). 

Edit Windows 
Path tools with editing capability allow the operator to change a path segment once it has been created.  
Examples of edit windows appear in each path section that is editable.  The coordinates box appears in the 
upper left hand corner of the edit window, showing all the coordinates programmed.  The following icons 
and buttons appear in edit windows to facilitate path editing: 

 

Move to Point – Move to the point highlighted in the coordinates box. 

 

Edit Point – Edit the point highlighted in the coordinates box. 

  Previous Point – Move to the preceding point in the path (if one exists). 
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  Next Point – Move to the next point in the path (if one exists). 

  Insert Point – Insert a new point BEFORE the current highlighted point. 

  Delete Point – Delete the highlighted point. 

  Append Point – Add a point to the end of the path. 

Interacting With the Dispensing System 
For PathMaster® to operate properly it must work in concert with the Dispensing System.  The Dispensing 
System must be in Manual mode in order to teach a path program online with PathMaster®.  If in Cycle 
Stop, the Dispensing System can be placed into this mode by pressing F4.  For more information on using 
the Dispensing System apart from PathMaster® please consult the separate Operation and Maintenance 
Manual within the Operating Guide. 

Manual/Jog/Teach Mode 
 

 

 

 

[F1] EXIT – Leave Manual/Jog/Teach mode and return to Cycle Stop. 

[F2] TEACH – Program the current point. 

[F3] VLV – Switch to Valve Selection. 

[F4] RUN – Run singular cycles of the current program. 

[F5] PURG – Actuate the current valve. 

[F6] TP – Momentary switch that displays the current position of the head.  

[F7] CONV – Switch to Conveyor Control. 

[F8] AXIS – Switch to Trackball Control. 

NOTE: Playback of a path is only possible if the operator is in Manual mode or one of its sub modes. 

Valve Selection, Conveyor Control and Trackball Control are the other areas accessible from Manual 
mode.  Valve Selection selects which valve is currently operational on the Dispensing System.  Conveyor 
Control operates the board stop and the conveyor.  

Trackball Control 
(All models except PVA250™, PVA750™, PVA2000C™) 

 

 

 

F7F6F5F4F3 F2 F1 

Manual Mode
EXIT Teach VLV RUN PURG TP CONV AXIS

F8 

F7F6F5F4 F3 F2 F1 

Trackball Control
EXIT Teach PRG X&Y X Y Z W

F8
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Trackball Control allows the operator to switch the active axis on the trackball. 

[F1] EXIT – Leave Trackball Control and return to the previous mode. 

[F2] TEACH – Program the current point. 

[F3] PURG – Actuate the current valve. 

[F4] X&Y – Operate the X and Y axes simultaneously. 

[F5] X – Operate only the X axis. 

[F6] Y – Operate only the Y axis. 

[F7] Z – Operate only the Z axis. 

[F8] W – Operate only the W axis. 

Teach Pendant 
PVA550™, PVA2000™, and PVA3000™ are equipped with a teach pendant which has a trackball, teach 
button, purge button, axis selection button, and LED indicators for selected axes and teach function.   

 

TRACKBALL – The trackball allows the operator to jog each axis independently or X and Y together. 

Teach – The teach button mimics the teach button found on the Dispensing System OIT in that it will 
register the gantry position back to PathMaster® when teaching a motion profile. 

Purge – The purge button mimics the purge button found on the Dispensing System OIT in that it will 
purge material from the active valve. 

Axis – The axis button allows the operator to toggle through the available axis configurations.  Typical 
configurations are X only, Y only, Z only, W only, and X & Y together. 

LED’s – The X, Y, Z and W LED’s represent the selected axis configuration.  The teach LED indicates a 
successful response from PathMaster® when a position is taught.  The teach LED is accompanied by a 
‘beep’ from the light tower buzzer. 
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OIT Jog Control 
(PVA250™, PVA750™, PVA2000C™  models only) 

 

 

 

 

OIT Jog Control allows the operator to jog the gantry via the OIT function keys to perform teach functions. 

[F1] EXIT – Leave OIT Jog Control and return to the previous mode. 

[F2] TEACH – Program the current point. 

[F3] PURG – Actuate the current valve. 

[F4] AXIS – Toggle axis control between X, Y and Z. 

[F5] -Y – Jog the Y axis in the negative direction. 

[F6] -X – Jog the X axis in the negative direction. 

[F7] +X– Jog the X axis in the positive direction. 

[F8] +Y – Jog the Y axis in the positive direction. 

To jog an axis, press and hold the function key that corresponds to the axis and direction of motion desired.  
Once the axis is in motion for approx. 1 sec, the speed will increase by a factor of 15. 

F7F6F5F4 F3 F2 F1 

Jog Mode
EXIT Teach PRG AXIS -Y -X +X +Y

F8
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TracMouse™ 
PathMaster® is equipped with the capability to jog the workcell gantry using a pointing device with your 
computer, such as a mouse or trackball.  This feature is especially useful on PVA250™, PVA750™, and 
PVA2000C™ machines that are not equipped with a teach pendant or built in trackball. 

The TracMouse™ has an activation pad or TracPad inside of each PathMaster® programming tool.  The 
TracPad™ is the dark gray square or rectangle located on each tool form.  Left click the TracPad™ to 
activate the TracMouse™.  To move the gantry, press and hold the left mouse button while dragging the 
mouse cursor on the TracPad™.  To switch between axes, right click the TracPad™ until the desired axis 
combination is displayed in the upper left hand corner of the activation pad.  Double click on the 
TracPad™ to teach a point while the TracMouse™ is active. 

 

Pneumatic Commands 
Pneumatic positions (head up/down, rotary selection) are not automatically programmed by
and there is no communication between the Dispensing System and PathMaster® concernin
pneumatic position.  Therefore, it is the responsibility of the operator to select the appropria
PathMaster® and insert the necessary pneumatic commands into the edit window after a pat
programmed.  Physically, the pneumatics are operated from the Valve Selection screen on t
System. 

Programming Tools 

Adding Comments 
It is a good practice to add comments to each path program in a manor in which anyone th
program can understand what the program is doing.  All comments are stripped from 
compilation; therefore, they do not use any controller memory. 

Comment Edit Window 
TracPad™
 PathMaster® 
g the valves 
te valve within 
h has been 
he Dispensing 

at views the path 
the program on 
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Move 
Programmed 

 

Teach Screen Edit Screen 

This tool allows the operator to program an absolute move.  This is a non dispense move. 

•  Approach Type – Select the order of movement for the function.  “XY Only” means the controller 
moves along the X and Y axes simultaneously.  “XY then Z” means the controller first moves X &Y 
and once that motion is complete it moves Z.  The total list of options: 

 
XY only XYZ 
X only XYW 
Y only XYW then Z 
Z only W only 

XY then Z XY then W then Z 
 
•  Current Position – If there is communication established with the controller, the current position 

appears in the text box.  Use the trackball on the Dispensing System to change the position. 
•  Input Coordinates – Manual entry of target position. 
•  Teach – Record current position and add to the program.  Equivalent to the F2 key on the Dispensing 

System.  
•  Teach Position – Record current position and alter program to use it.  Equivalent to the F2 key on the 

Dispensing System.  
•  Teach Coordinates – Record entered position and alter program to use it. 
•  Cancel – Quit without altering the program. 
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2D Path 
Programmed 

 

Teach Screen 

 

Edit Screen 

 

This tool teaches 2D path segments.  The Z axis does not alter its position during the path. 

•  Current Position – If there is communication established with the controller, the current position 
appears in the text box.  Use the trackball on the Dispensing System to change the position. 

•  Input Coordinates – Manual entry of target position. 
•  Dispensing Parameters – Select appropriate parameters for the current dispense, including the active 

valve.   
� Valve On Time – The pause after turning the valve on but before starting the dispense path. 
� Valve Off Time – The pause after finishing the path and turning the valve off but before 

moving to the next point.  
� Valve On Distance – Distance the path traveled before turning the valve on. 
� Valve Off Distance – Distance the path traveled when turning the valve off, before the path 

finishes. 
•  Teach – Record the current point.  Equivalent to the F2 key on the Dispensing System.  
•  Done – Add to the program.  
•  Cancel – Quit without altering the program. 
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NOTES:  Playback is only allowed if the Dispensing System is currently in Manual/Jog/Teach mode. 

3D Path 
Programmed 

 

Teach Screen 

 

Edit Screen 

 

This tool teaches 3D path segments. 

•  Current Position – If there is communication established with the controller, the current position 
appears in the text box.  Use the trackball on the Dispensing System to change the position. 

•  Input Coordinates – Manual entry of target position. 
•  Dispensing Parameters – Select appropriate parameters for the current dispense, including the active 

valve.   
� Valve On Time – The pause after turning the valve on but before starting the dispense path. 
� Valve Off Time – The pause after finishing the path and turning the valve off but before 

moving to the next point.  
� Valve On Distance – Distance the path traveled before turning the valve on. 
� Valve Off Distance – Distance the path traveled when turning the valve off, before the path 

finishes. 
•  Teach – Record the current point.  Equivalent to the F2 key on the Dispensing System.  
•  Done – Add to the program.  
•  Cancel – Quit without altering the program. 
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NOTES:  Playback is only allowed if the Dispensing System is currently in Manual/Jog/Teach mode.  

Arc 
Programmed 

 

Teach Screen 

 

Edit Screen 

 

This tool teaches an arc.  The operator must select three (3) points on the arc length, including the 
beginning and end points, moving (clockwise or counter-clockwise) in the direction the axes must move. 
The Z axis does not alter its position during the path. 

NOTE:  When selecting points, space them evenly around the arc. 

•  Current Position – If there is communication established with the controller, the current position 
appears in the text box.  Use the trackball on the Dispensing System to change the position. 

•  Input Coordinates – Manual entry of target position. 
•  Dispensing Parameters – Select appropriate parameters for the current dispense, including the active 

valve.   
� Valve On Wait – The pause after turning the valve on but before starting the dispense path. 
� Valve Off Wait – The pause after finishing the path and turning the valve off but before moving 

to the next point.  
� Valve On Distance – Distance the path traveled before turning the valve on. 
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� Valve Off Distance – Distance the path traveled when turning the valve off, before the path 
finishes. 

•  Teach – Record current position.  Equivalent to the F2 key on the Dispensing System.  
•  Done – Add to the program. 
•  Cancel – Quit without altering the program. 
 
NOTES:  Playback is only allowed if the Dispensing System is currently in Manual/Jog/Teach mode.  
Only three points can be plotted for the arc function. 

Circle 
Programmed 

 

Teach Screen 

 

Edit Screen 

 

This tool teaches a circle.  The operator must select three (3) points on the circumference of the circle, 
including the start point, moving (clockwise or counter-clockwise) in the direction the axes must move. The 
Z axis does not alter its position during the path. 

NOTES:  When selecting points, space them evenly around the circle.  Do not use the same point as the 
first and last point. 
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•  Current Position – If there is communication established with the controller, the current position 
appears in the text box.  Use the trackball on the Dispensing System to change the position. 

•  Input Coordinates – Manual entry of target position. 
•  Dispensing Parameters – Select appropriate parameters for the current dispense, including the active 

valve.   
� Valve On Wait – The pause after turning the valve on but before starting the dispense path. 
� Valve Off Wait – The pause after finishing the path and turning the valve off but before moving 

to the next point.  
� Valve On Distance – Distance the path traveled before turning the valve on. 
� Valve Off Distance – Distance the path traveled when turning the valve off, before the path 

finishes. 
•  Teach – Record current position.  Equivalent to the F2 key on the Dispensing System.  
•  Done – Add to the program. 
•  Cancel – Quit without altering the program. 
 

NOTES:  Playback is only allowed if the Dispensing System is currently in Manual/Jog/Teach mode.  
Only three points can be plotted for the circle function. 

Area 
Programmed 

 

Teach Screen 

 

Edit Screen 
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This tool teaches rectangular paths. The Z axis does not alter its position during the path. 

•  Current Position – If there is communication established with the controller, the current position 
appears in the text box.  Use the trackball on the Dispensing System to change the position. 

•  Input Coordinates – Manual entry of target position. 
•  Dispensing Parameters – Select appropriate parameters for the current dispense, including the active 

valve.   
� Valve On Wait – The pause after turning the valve on but before starting the dispense path. 
� Valve Off Wait – The pause after finishing the path and turning the valve off but before moving 

to the next point.  
� Valve On Distance – Distance the path traveled before turning the valve on. 
� Valve Off Distance – Distance the path traveled when turning the valve off, before the path 

finishes. 
� Area (or Path) Spacing – Distance between runs. 

•  Teach – Record the current point.  Equivalent to the F2 key on the Dispensing System.  This button 
becomes inactive after the third point is taught. 

•  Done – Add to the program.  
•  Cancel – Quit without altering the program. 
 
NOTES:  Playback is only allowed if the Dispensing System is currently in Manual/Jog/Teach mode.  
Only three points are required for the Area tool. 

How the Area tool works 
 

 Area #1 Area #2 
 
1             1     2 
       
 
 
 
 
 
 
                        3 
2 3  
 
 
 
 
 
 Points 
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By using only three points ‘Area’ path segments are calculated in the following manner: 

Point 1 defines the start of the pattern.  Point 2 defines the direction and length of the pattern.  After the 
direction of the pattern is determined, the distance from point 1 to point 3 determines the width of the 
pattern.  The width is divided by the ‘Area Spacing’ (or ‘Path Spacing’) parameter on the Area tool screen.  
The resulting value is the number of passes needed to fill the given area. 

NOTE:  For the above drawings, the X axis is vertical and the Y axis is horizontal. 

Area #1  
1) Point 1 defines the start. 

2) Point 2 is along the X axis, so that is the direction of the path.  The length of the path is the distance 
over the X axis.  Therefore, the width is along the Y axis. 

3) Point 3 defines the width.  The width is the difference in Y between points 1 and 3.  This is divided by 
the ‘Area Spacing’ (or ‘Path Spacing’) parameter resulting in the number of paths the machine needs to 
run to fill the given area. 

Area #2  
1) Point 1 defines the start. 

2) Point 2 is along the Y axis, so that is the direction of the path.  The length of the path is the distance 
over the Y axis.  Therefore, the width is along the X axis. 

3) Point 3 defines the width.  The width is the difference in X between points 1 and 3.  This is divided by 
the ‘Area Spacing’ (or ‘Path Spacing’) parameter resulting in the number of paths the machine needs to 
run to fill the given area. 

FastArea™ 
FastArea™ quickens the pace of the standard area by eliminating valve cycling between rows.  This feature 
can have a dramatic impact on cycle time.  To activate the FastArea™ feature; teach a standard area, and 
then check the FastArea™ check box. 

 

FastArea™
Check box 
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FastMask™ 
The FastMask™ tool will create an area to be coated as well as keep outs of within that area.  There can be 
up to 99 keep out areas defined within the coating area. 

 

 

 

 

 

Once the Fastmask™ tool is selected, a wizard will open: 

 

Select the appropriate valve parameters, then teach the opposing corners of the area to be coated, point 1 
and point 2.    

Click Next to continue: 

 

Teach the opposing corners of the first keep out area.  Click Add to add the keep out to the FastMask™ list.  
Keep adding keep out areas (up to 99 keep outs) until all non-coat areas have been included in the 
FastMask™ list. 

Click Next  to continue: 

Sample PCB

Keepouts
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Select the direction of the brush stroke.  This is the direction the coating valve will travel when completing 
the FastMask™ pattern. 

Click Next to continue: 

 

The FastMask™ wizard is complete.  Click Finish. 

The FastMask™ pattern will always begin at the point taught closest to the origin of the gantry (the 
smallest coordinate in the pattern). 

PolyLine 
A polyline is a series of 2 dimensional lines, arcs, and circles.  Polylines can be very useful in applications 
that require tight directional changes at higher speeds.  Combining lines with arcs and circles will smooth 
the motion and create uniform corners and circles. 

A polyline can be created using two different methods.  Multiple path segments can be created using the 
conventional method and then converted to a polyline, or the polyline can be created using the PolyLine 
tool. 

New Polyline 
To create a new polyline, open the PolyLine tool, and select a programming tool from the polyline toolbar 
on the left.  Teach the points required for the tool selected, and set the speed.  As you complete each 
segment it is added to the command list on the left of the polyline program table.  The polyline is limited to 
511 points for all segments.  Set the valve parameters.   
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NOTE: When teaching each segment in a polyline, the last point of the last segment will be used as the 
first point of the new segment.  For example, a polyline arc (assuming it is not the first segment of the 
polyline) will only require teaching two points since the first point will be taken from the last point of the 
previous segment. 

Select a segment in the command list and click the Edit Point button or the Edit Speed button to edit the 
points and speed for each segment.  The polyline can also be exploded into individual path segments and 
modified on the main PathMaster® program table. 

Once the polyline is complete click the Done button. 

 

 

From Selected Line 
To create a polyline from existing path segments, simply select the path segments to include in the polyline, 
access the Teach menu and select PolyLine -> From Selected Lines.  If the endpoints of the path segments 
do not match up exactly, PathMaster® will ask you if you would like to match up the endpoints.  If you 
choose not to match up the points the polyline will not be created.  If you choose to match up the points, the 
polyline will match up the points using the best fit. 

When creating a polyline from existing path segments, the valve parameters will be taken from the first 
path segment in the series.  The speeds will be retained for each path segment. 

WARNING: Be sure that all path segments selected for a polyline use the same valve as PathMaster® 
will assume that the valve used in the first segment is used throughout. 

 

Dot 
Programmed 

 

Teach Screen 

PolyLine 
Toolbar 

Command 
List 

Polyline Program 
Table 
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Edit Screen 

 

This function teaches a timed dispense. 

•  Current Position – If there is communication established with the controller, the current position 
appears in the text box.  Use the trackball on the Dispensing System to change the position. 

•  Input Coordinates – Manual entry of target position. 
•  Dispensing Parameters – Select appropriate parameters for the current dispense, including the active 

valve.   
� Valve On Wait – The length of time the valve remains on. 
� Valve Off Wait – The pause after turning the valve off but before moving to the next point.  
� Z Retract (Relative) – Distance to raise the Z axis after completing certain moves. 

•  Teach – Record current position and add to the program.  Equivalent to the F2 key on the Dispensing 
System.  

•  Cancel – Quit without altering the program. 
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Head 
Programmed 

 

Entry Screen 

 

This function allows the operator to enter head (valve) commands into the edit window.  The command is 
placed at the active field location. A head function only appears in the head tool once it has been 
configured in the machine parameter setup.  Pneumatic positions (head up/down, rotary selection) are not 
automatically programmed by PathMaster® and there is no communication between the Dispensing System 
and PathMaster® with regard to the active valve or its pneumatic position.  Therefore, it is the responsibility 
of the operator to select the appropriate valve within PathMaster® and to insert the necessary pneumatic 
commands into the program after a path has been completed.  See Inserting Valve Commands into 
Programs on page 17 for further information about head function programming. 

•  Teach – Accept the current command and insert into the edit window. 
•  Cancel – Quit without generating code. 
 

Step Over 
The step over tool will allow you to step to the previous or next path segment and play it back wet or dry. 
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Quick Play 
The quick play tool will play back the selected path segments in wet or dry mode.  This is the equivalent of 
using the Run Selection option on the menu. 

 

 

Dwell 
The Dwell tool will set a delay in program execution in between path segments. 

 

Subroutine 

Creating 

•  Highlight the commands to be included in the subroutine. 
•  Select the Teach -> Subroutine -> Create option from the main menu. 

 
•  This function allows the operator to use an existing command line element excluding DMC 

commands, in an array sequence or in random placement. You also have the option to insert 
existing subroutines in your program using ‘Insert’.  



 

PathMaster® Manual  Rev. H 6/03 
- 51 - 

  
•  Choose an abbreviated name and brief 

description for the subroutine. The description 
serves to assist the operator when selecting 
from multiple saved subroutines. 

•  Choose a reference point on the part to 
group the command line sequences. Each 
execution of the subroutine to be arrayed 
or random placed will be referenced from 
this point of origin.  

  
•  Choose to create an array or select random 

placement of the subroutine. 
•  This screen corresponds to random 

program placement. By selecting the 
‘Teach’ button, PathMaster® utilizes the 
current location of the end effector as an 
execution point. 

  
•  Select the direction of the array. The arrows 

assist in determining the direction in relation to 
X,Y  0,0 origin of the current machine. 

•  Define the number of elements in the X 
direction and the Y direction. 
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•  Assign the first and last points of execution. 

The coordinates to be entered are relative to the 
point of origin assigned in the previous steps. 
PathMaster® then calculates the distance for X 
and Y spacing. 

•  This screen confirms the final step. By 
selecting finish, PathMaster® saves your 
created array or random placement and 
inserts it into your program.  The chosen 
execution positions will appear in the main 
window. 

Editing 
•  Save the current project. 

•  Select File -> Open -> Subroutine and choose the subroutine from the list. 

•  The stored subroutine code appears.  Edit it like normal. 

•  Save the subroutine and reopen the current project. 

I/O 
Teach Screen 

 

This function allows the operator to control outputs or wait for an input to be in a particular state.  The I/O 
for this Dispensing System is located in the Machine Specific Information section of the Operating Guide.   
Operators who understand discrete I/O and its usage should only use this command.  

•  Function – Select “Wait for input” to hold the program until an input is in the desired state.  “Set 
Output” turns a discrete output on or off. 

•  Bit # – Location of the discrete I/O bit referenced. 
•  Value – The ON/OFF status desired.   
•  Teach – Accept the current command and add to the program. 
•  Cancel – Quit without altering the program. 
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DMC Command 
Programmed 

 

Teach Screen 

 

Edit Screen 

 

This function allows the operator to enter DMC code into the program.  Operators who thoroughly 
understand the DMC language and its usage should only use this. 

•  Done – Accept the current code and add to the program. 
•  Cancel – Quit without altering the program. 
 

Valve Offsets 
To use the offline programming feature or a pointing device with PathMaster®  the valve offsets must be 
set correctly. A valve offset is the distance between a pointing devices and a valve.  A pointing device 
could be another valve, a laser pointer, or a camera. 

Open the Machine parameters window by selecting the Setup -> Machine Parameters option from the main 
menu.  Click the Valve Offsets button. The valve offsets form will display. PathMaster® must measure the 
offset for each valve relative to the pointing device. To measure this distance the offset wizard will step 
through a series of instructional screens. The process will be to teach a valve at a fiducial point and then the 
pointing device.  This process repeats for each valve until all offsets are programmed 

The process in our example will be for a two valve system. The first valve is called spray and the second 
valve is called needle. Follow the directions on the screen.  
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Move valve one  (spray) over a fiducial which both the pointing device and valve one can reach. Click the 
Teach button when valve one is over the fiducial, making sure that the Z height is considered in the taught 
position.   

 
 
Next move the pointing device over the fiducial. Click the Teach button. The distance between the pointing 
device and the fiducial has now been taught. 
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The next offset must be taught.  Move valve two  over the fiducial and click the Teach button.  

 

 
 
Move the pointing device to the same location and press the Teach button.  

The valve distances have now been taught. 
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The offsets have been taught. Click the Done button to save the valve offsets. 

Click the Save and Close button to exit Machine Parameters. 

 

Offline Programming (FastPath™) 
Before using FastPath™, valve offsets must be configured.  For more information on configuring valve 
offsets, refer to the Valve Offsets section of this manual. 

Setting Up the Image 
Open a new program. Click Edit->Program->Background Image. Choose the background image by 
clicking the Change Image button. If no image is selected the default image will be used. The default image 
is a 500mm by 500mm image with a workspace of the same size.  The background image must be of a 
known size preferably the same size as your circuit board or entity to be dispensed upon. Type the board 
width (left to right) and the board height (top to bottom) of your board into the appropriate boxes using the 
corresponding units of measurement. Align your image to your workspace. The image may be aligned a 
number of ways. A good reference point could be the lower right of your image and the valve one 
coordinates for the intersection of the front rail and the board stop of your machine. Choose the reference 
point type and then find the machine coordinates for the same location. Type the valve one coordinates into 
the robot reference point edit boxes. 

You have successfully setup your machine to use offline programming. Repeat these steps for each path 
program that will be taught using FastPath™. 

Valve Selection 
Valve selection selects the valve for each successive path segment for FastPath™. The valve selection is 
important because the valve offsets are taken into consideration to make the robot coat on the image where 
requested. If the valve offsets are not properly setup prior to using FastPath™, the path program will not 
run correctly. Select the appropriate valve prior to selecting a programming tool. The selected valve can be 
changed while using any programming tool as long as the new valve is selected prior to completing the 
path segment.  For example: if user creates the first two coordinates of an area with valve one then selects 
valve 2 and completes the third point the path segment will be created using valve two. 
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Drawing a Program 
 

 

 

You have setup you machine and program for FastPath™ and now it is time to draw your program on your 
image. 
 
Press CNTRL+F (or click the FastPath™ icon on the programming toolbar) to open the FastPath™ 
window. The window opens. Press the Zoom-In and Zoom-Out buttons to get the image to a working size. 
Next choose which command you would like to use to generate a path segment. Each command will be 
inserted into your program above the highlighted portion of your path program. Each command will be 
added to the program table in succession until another object or path segment is selected. Once another 
object or path segment is selected, the insertion point for the next path segment will be above the 
highlighted or selected path segment in the program table.  Press CNTRL+F to close the FastPath™ 
window and return to the normal PathMaster® editing window. 
 
Most PathMaster® programming tools are available when using FastPath™.   Each programming tool is 
used within FastPath™ similar to the way it would be used for online programming.  Once a tool is 
selected, instead of pointing and teaching a position on the workcell, the FastPath™ points will be taught 
on the board image in the FastPath™ window using the corresponding valve. 
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Commands 
NOTE: All programming tool procedures listed below are for FastPath™ only. Each path segment 
taught corresponds to the valve selected in the FastPath™ toolbar. 

Move 
Click the Move Icon on the FastPath™ toolbar. Next click the location within the image where you would 
like to move. The move form is displayed as normal. Make any modifications to the move location and 
click the Done button.  The Cancel button will cancel the creation of the move command. 

Head 
The head tool adds an appropriate pneumatics head command to the path program. 

2D Line 
The 2D Line tool creates a line less than or equal to 511 points. Click the 2D Line button to select the tool. 
Next click all the points of the line on the image form. Each time a point is taught, the cursor will briefly 
become a crosshair indicating that the point was registered. When you are done creating all points, right 
click the mouse to complete the 2D Line. The 2 dimensional line will display on the board image with a 
spray or dispense width equal to the area spacing parameter of the selected valve. The 2D line can be edited 
graphically. See editing offline commands. 

Arc 
The Arc tool is created with two endpoints and a mid point. Click the Arc button to select the tool.  Each 
time a point is taught, the cursor will briefly become a crosshair indicating that the point was registered. 
The arc will display on the board image as a complete circle. The playback of the arc will be the number of 
degrees between the points. 

Circle 
The Circle tool is similar to the Arc tool except that a full circle is created with three points.  Click the 
Circle button to select the tool.  Each time a point is taught, the cursor will briefly become a crosshair 
indicating that the point was registered.  The circle will display on the board image. You may edit the circle 
by dragging any point of the circle to a new location. This will change the radius and location of the entire 
circle. Dragging the center point does nothing. It is displayed for reference. 

Area 
The Area tool is created using three points. Click the Area button to select the tool.  Click any three points 
to generate an area command. The area command will behave as normal and the brush stroke will be from 
point one to point two. The area pattern will progress one brush stroke at a time in the direction from point 
two to point three. 

FastMask™ 
The FastMask™ tool is used to create a coating area followed by keep out areas within the coating area. 
Click the FastMask™ button to select the tool.  The first two point taught using FastMask™ define the 
opposing corners of the coating area.  After the coating area is defined, a dialog box will appear asking the 
user to define the number of keep out areas within the coating area. A maximum of 99 keep out areas are 
allowed. Enter the number of keep out areas and click OK.  Teach the opposing corners of each successive 
keep out area until the total number of keep out areas have been defined. The FastMask™ will display on 
the board image as a blue coating area with red keep outs. 
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Dot 
The Dot tool creates a dot at the specified location on the board image. Click the Dot button to select the 
tool.  The default dot on and off parameters for the selected valve are used for each dot. 

Editing the commands 
Objects taught on the board image may be modified once created.  To modify or edit an object, click on the 
object to select it.  Once the object is selected, its points can be dragged to a new location. An Area object 
can be resized by dragging its corners. The FastMask™ object can be resized in a similar manor.  The 2D 
Line object can be modified by selecting the object.  Once the object is selected,  right click the object to 
reveal the edit menu (a popup menus will appear).  Select Edit Path. The vertex points of the path will 
appear as squares. These points may be dragged around to change the 2D Line. Points may be added or 
deleted. Right click on a point and then left click on Delete to delete this point. Right click in between two 
points and click Add Point to add a point. When  finished editing the object, click background image 
outside of the object to register your changes and update the object. 

Password Protection 
To prevent unauthorized or accidental changes to project files in PathMaster® and in the Dispensing 
System, password protection can be added to the download and save functions in PathMaster®. 

Download Password 
To add password protection to the download function in PathMaster®, select the Setup -> Password -> Set 
Download Password option from the main menu.  If no password exists, you will be asked if you would 
like to create one.  If a previous password exists, you must enter it correctly to continue.  Next enter the 
new password, click OK.  Then re-enter the password for verification and click OK.  The PathMaster® 
Download Project and Download Main functions are now password protected.  When either download is 
attempted, a password will be required to perform the download.  If the password is entered incorrectly, the 
download is aborted. 

Save Password 
To add password protection to the save function in PathMaster®, select the Setup -> Passwords -> Set Save 
Password option from the main menu.  If no password exists, you will be asked if you would like to create 
one.  If a previous password exists, you must enter it correctly to continue.  Next enter the new password, 
click OK.  Then re-enter the password for verification and click OK. The PathMaster® save function is now 
password protected.  When a Save or Save As function is attempted, a password will be required to perform 
the save.  If the password is entered incorrectly, the save is aborted. 

Changing Password 
To change the save or download password, repeat the corresponding process listed above using the new 
password in place of the old. 

Resetting Password 
To reset the save or download password, repeat the corresponding process listed above, but do enter a new 
password in the new or confirm password fields. 
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Importing Files 
The PathMaster® import function can import programs, projects, subroutines, and CAD files. 

CAD Files 
A 2-dimensional drawing generated in CAD can be imported into PathMaster® as a path program. 

There are several steps required for a successful import.  These include: 

•  Creation of the path  drawing in CAD. 

•  Adding PathMaster® codes to the CAD drawing. 

•  Orienting the CAD drawing relative to the Dispensing System gantry. 

•  Exporting the CAD drawing to a *.dxf (AutoDesk Drawing Exchange Format) 

•  Importing the CAD drawing into PathMaster® using the CAD wizard. 

Preparation of the CAD File 
Below is the original drawing (Figure 1) and the required elements. (Table 5)  NOTE: The CAD X+ and 
CAD Y+ arrows are for reference only.  These are not required. 

 

Figure 1: Original CAD Layout 

Required Element Description 
BEGIN1, BEGIN2, etc. Defines the start of the segment.  The valve will turn 

ON at this point. 

END1, END2, etc. Defines the end of the segment. The valve will turn OFF 
at this point. 

UNITS=IN.  or 
UNITS=MM.  or 
UNITS=CNTS. 

Defines the units used for creating the drawing. Note:  
During the import process the path will be 
automatically converted to the units defined in 
PathMaster. 

Table 5 - Required CAD File Elements 

After all necessary elements have been included in the drawing it must be MIRRORED on the Y axis. 
(Figure 2) NOTE: In AutoCAD be sure to “Delete Old Objects” when prompted”. 
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Figure 2: CAD drawing Mirrored on Y axis 

The drawing must be Rotated Clockwise 90 degrees (-90deg for standard AutoCAD Setup). (Figure 3)  

 
Figure 3: CAD Drawing rotated 90deg. 

The final step is to export the file to a *.dxf. 
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In AutoCAD: 

•  Click the File->Export menu. 

•  When the Export Data window comes up, select  Save As Type AutoCAD R12/LT2DXF. 

•  Under the Options button ensure that the Export Format is ASCII. 

•  Give the file a name and save it. 

Importing the file into PathMaster 
The path will be imported to a new program.   

Click on File ->Import ->Program ->DXF File.  Te following screen appears. (Figure 4) 

 

Figure 4: PathMaster import screen #1 

The snap to tolerance must be set properly to allow the import process to recognize the proper associations 
between drawing segments in the CAD file.  A minimum of 0.015” is recommended.  NOTE:  This does 
not affect the accuracy of the path.  It only allows for proper translation of the drawing entities. 

Choose the method of importation (Figure 5).  Paths from Begin to End will import the file as drawn, with 
proper segment ordering (BEGIN1,END1, etc.) observed.  All Entities ignores commands for order of 
operations, but is useful for large files with many paths, such as placement of dots, where each segment 
may not be numbered. 

 

Figure 5:  PathMaster import screen #2 

Choose the location of the starting point. (Figure 6)  This can be taught via trackball from the machine OIT 
or a typed location. 
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Figure 6: PathMaster import screen #3 

Select the file to import. (Figure 7) 

 

Figure 7: PathMaster import screen #4 

After a successful import the path will be displayed in a path preview window. 

 

Figure 8: PathMaster import screen #4 

The file will be imported as individual paths. (Line, Arc, etc.)  The paths are ready for playback or may be 
converted to a polyline. 
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PathMaster® 1.5 & Pre 1.5 Projects 
To import a PathMaster® 1.5 or pre 1.5 project, select the File -> Import -> Project -> PathMaster 1.5 or 
Pre PathMaster 1.5 option from the main menu.  When the file dialog box opens, select the location and the 
file name of the project to import.  Click Open.   

NOTE:  You may need to change the file filter (type) to *.txt, or *.dmc to see the project file in the dialog 
box. 

Text File 
A properly format tab delimited text file can be imported into PathMaster® as a path program.  Select the 
File -> Import -> Program -> Text File option from the main menu.  When the file dialog box opens, select 
the location and the file name of the project to import.  Click Open.  A text file program is typically a file 
that was exported as a text file from PathMaster® 

NOTE:  You may need to change the file fitler (type) to *.txt to see the project file in the dialog box. 

DMC File 
A properly format DMC file can be imported into PathMaster® as a path program.  Select the File -> 
Import -> Program -> DMC File option from the main menu.  When the file dialog box opens, select the 
location and the file name of the project to import.  Click Open.   

NOTE:  You may need to change the file filter (type) to *.dmc to see the project file in the dialog box. 

Subroutine 
A properly formated subroutine can be imported into PathMaster® using the import subroutine option.  
Select the File -> Import -> Subrotuine -> Text File option from the main PathMaster® menu or the File -> 
Import subroutine option from the subroutine edit window menu.  Select the location and name of the 
subroutine and click the Open button. 

NOTE:  You may need to change the file filter (type) to *.txt to see the project file in the dialog box. 

Once the import is complete, the subroutine edit window will be open. 

Exporting Files 
The PathMaster® export function can export programs, projects and subroutines. 

Text File 
To export a program to a tab delimited text file, select the File -> Export -> Program -> Text File option 
from the main menu.  When the dialog box appears, select a location and file name for the program, and 
click Save. 

DMC File 
To export a project to a DMC or DMC compressed file, select the File -> Export -> Project - > DMC File 
or Compressed DMC File from the main menu. When the dialog box appears, select a location and file 
name for the program, and click Save. 
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Subroutine 
To export a PathMaster® subroutine to a tab delimited text file, select the File -> Export -> Subroutine -> 
Text File option from the main PathMaster® menu or the File -> Export Subroutine option from the 
subroutine edit window menu.  Select the location and name of the subroutine and click the Save button. 

Utilities 
PathMaster® has a variety of utilities to help with debugging, the Dispensing System, as well as path 
programs.  These utilities can be found under the Utilities menu. 

View FastPath 
To open the FastPath™ window for offline programming, select the Utilities -> View FastPath option from 
the main menu.   

NOTE: The FastPath™ window can also be accessed using the FastPath™ button on the programming 
toolbar. 

Measure Distance 
The distance measurement tool is used to measure the distance between two point using current 
measurement units.  To open the tool, click the Utilities -> Measure Distance option from the main menu.  

To measure distance, move the head to the first point, click Teach Point 1.  Move the head to the second 
point, click Teach Point 2.  Click the Calculate Distance button.  The distance will be calculated and 
display. 

 

Machine Debugger 
The machine debugger is an array of tools to aid in the debugging of the Dispensing System.  To access one 
of the debugging tools, select Utilities -> Machine Debugger from the main menu.  When the machine 
debugger opens, select the tab for the tool to be used. 
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Terminal 
The terminal lets the operator send commands directly to the controller.  To send a command to the 
controller, ensure the keyboard caps lock is on, type the command in the terminal window, and press the 
Enter key.  A response from the controller will display under the command that was issued. If the controller 
does not understand what it received, it will respond with a “?”. 

 

Some guidelines for working directly with the controller are listed below.  For more information on using 
the terminal or working directly with controller, consult the online controller manual. 

DMC Programming Basics 
•  All commands must be given in uppercase letters. 

•  Positions are given in counts.  In most cases there are 5080 counts per inch, 200 counts per millimeter.   

•  No line of code may contain more than 80 characters. 

•  A semicolon (;) is used as a carriage return.  This allows for multiple commands on the same line and 
can be used to save space in the program. 

Labels 
Sections of a program (subroutines) are defined by labels.  Labels start with the pound (#) sign followed by 
a maximum of seven characters.  The first character must be a letter; after that, numbers are permitted.  
Spaces are never permitted.  PathMaster® generates its own labels for programs.  These labels do not 
appear in the edit window, so the operator cannot alter them. 

No duplicate labels are allowed anywhere in memory.  The Main program and PathMaster® are written 
without any duplicate labels.  However, it may be necessary for the operator to insert special labels into 
programs.  If any duplicate labels occur anywhere within a PathMaster® project, the operator must find the 
duplication and fix it.  These errors most commonly occur when a section of code has been copied and 
pasted elsewhere.  There can be no duplicates anywhere within a project, which includes all 30 programs 
in that project. 
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Labels must appear at the start of a line.  An operator manually entering code must ensure that no labels 
exist in the middle of a line.  This generates an error when running the program. 

Important Commands 
The DMC programming language contains over 135 commands.  For programming the Dispensing System 
the majority of these commands are not used and even fewer are used for creating dispense paths.  The 
following commands are the most important for an advanced operator to know.  A complete list of 
commands can be found in the separate DMC-1500 manual that accompanied the machine.  Any reference 
to manually changing or querying in the examples below requires the use of the terminal option in 
PathMaster® to communicate directly with the controller. 

Table 6 – Important DMC Commands 

Cmd Description Example Tips 
AC Acceleration for 

independent moves are in 
counts per second². 

AC*=100000 (sets all 
axes), ACX=100000 (only 
sets the X axis 
acceleration) 

Make sure the value of the 
acceleration is high enough to get the 
motion to speed within a reasonable 
amount of time. 

AM After move. This command 
holds the program until the 
movement on the specified 
axes is completed.  

AM (wait for all axes to finish 
its motion), AMS (wait for 
coordinate sequence to finish 
motion). 

The AM command tests for profile 
completion. Use the AM command 
to separate multiple movements. 

AV After vector distance. This 
command holds the program 
until a specified distance has 
been traveled during a 
coordinated move. The units 
are in counts. 

AV1000 (wait until the axes 
have moved 1000 counts). 

The AV command resets to zero 
after every use. It can be calculated 
by summing the distances between 
each point on the coordinated move. 

BG Begin. BG starts a motion on 
an axis or a sequence. 

BGX (begin motion on the X 
axis), BGS (begin motion 
sequence), BG (begin motion 
on all axes). 

A second BG command cannot be 
given until the first BG motion is 
finished. The AM command can be 
used to hold the program until the 
first motion is complete. It is best to 
specify the exact axes to put into 
motion. The BG command by itself 
starts ALL the axes according to the 
last specified motions. 

BL Reverse Software Limit   
CB Clear bit. Clears a bit on the 

output port.  
CB40 (clears the bit for the 
buzzer). 

Clearing a bit in DMC terminology 
turns the bit on. The opposite of CB 
is SB (set bit). A complete list of the 
outputs can be found in the Machine 
Specific Information section of the 
Operating Guide. 

CR Circle.  Specifies a radius, a  
starting angle and the angle to 
be traversed. Movement is 
counterclockwise, by default, 
in the Cartesian coordinate 
system. This is either 
clockwise or 
counterclockwise, as viewed 
from the front of the machine, 
depending upon the 
mechanical setup of the 

CR 5000,90,180 (arc with 
length of 5000 counts, starting 
at 90° and doing a half circle 
(180°)). 

The circle command is a coordinated 
two dimensional move. The structure 
is the same as all other coordinated 
moves, using the VM, VP and VE 
commands (see Examples of 
Dispense Programs on page 44).A 
start angle of 0° produces a circle, 
relative to the start point, entirely 
negative in the X direction and half 
positive, half negative in the Y. 
Starting at 180° yields an entirely 
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machine. Specifying a 
negative traverse angle yields 
clockwise motion in the 
Cartesian coordinate system.  

positive X circle and a half positive, 
half negative Y. Similarly, 90° is an 
entirely negative Y circle, 180° 
entirely positive Y, with both having 
X half positive, half negative.  

CS Clear Sequence Clears Memory of prior coordinated sequences. 

DC Deceleration for independent 
moves. The units are in counts 
per second².  

DC*=100000 (sets all axes), 
DCX=100000 (only sets the X axis 
deceleration), DC 
10000,30000,40000 (sets X, Y and 
Z Decelerations separately).  

The higher the deceleration, the 
faster an axis stops its move. 

DE Dual (Auxiliary) Encoder Position  
DL Download. This transfers a text 

file from the computer to the 
controller.  

DL (then select a text file to 
download). 

Use the HX (halt execution) 
command before using DL. 
Damage may result otherwise. 

EN End. This terminates a subroutine, 
program thread or program.  

EN The Dispensing System also 
has a subroutine used for a 
conditional end.The command 
JP#NOOP operates the same as 
the EN command. 

FL Forward Software Limit   
HX Halt execution. Halts the execution 

of the program or any of its 
threads. 

HX1 (halt thread 1), HX (halt 
the entire program). 

Always use the HX command 
before executing a DL 
command. 

JG Jog   
JP Jump to a program location. 

Locations are marked by labels. 
This command can be used in a 
conditional statement and the jump 
occurs if the conditional is true. 

JP#NOOP (jump to location 
#NOOP), 
JP#NOOP,COUNT>10 (jump 
to location #NOOP if the value 
of COUNT exceeds 10). 

It is important not to confuse 
JP with JS. Using a JP when a 
JS is required results in the 
thread being halted once the 
EN command is reached. 

JS Jump to subroutine. Subroutines 
are marked by labels.  

JS#H1UP (jump to subroutine 
#H1UP). 

It is important not to confuse 
JS with JP. Using a JS when a 
JP is required can result in 
“nesting” the program 
continuously until a nesting 
error occurs. Subroutines can 
only be nested 16 deep. 

LI Linear Interpolation Distance   
LM Linear Interpolation Mode   
LS List. The operator can list a single 

line or multiple lines of the 
program in a terminal screen.  

LS 300,0 (show line 300), LS 
250,270 (show lines 250 to 
270), LS (show all lines in 
memory). 

If a runtime error occurs, use 
the LS command in the 
terminal screen to check the 
line containing the error. 

MG Message. This command sends 
data out the bus. It can also be 
used by the operator to query the 
controller for information.  

MG “Path Complete” (displays 
the message “Path Complete” 
on the terminal screen), 
MG@IN[60] (displays the 
value of input 60, where 0 is on 
and 1 is off). 

Do not put message commands 
in programs! If there are 
message commands, and there 
is no computer attached to the 
Dispensing System, the 
controller halts once the output 
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buffer is full. 

MO Motor off. Shuts off motor control. MO (turn all motors off), MOX 
(turn off only the X axis 
motor). 

 MO shuts off the motor(s).The 
motors are reactivated with the 
SH (servo here) command. 

MR Reverse Motion to Position   
MT Motor Type   
NO No operation. This command 

performs no action and is used to 
comment a program.  

NO!!! PROGRAM 1!!!! 
(description for program). 

A semicolon (;) terminates the 
NO command. Any statements 
following a semicolon are 
executed.  

PA Position absolute. This sets the 
destination of a move, referenced 
to the origin. The units are in 
counts. 

PA 10000,10000,1000 
(commanded position for X, Y 
and Z axes), PAX=10000 
(commanded position of X 
axis). 

It is best to limit the use of the 
PA command to designating 
the start of a dispense path. 
Overuse of the PA command 
complicates program editing.  

PF Position Format   
PR Position relative. This sets the 

incremental position of the next 
move, referenced to the current 
position. The units are in counts. 

PR 10000,10000,1000 
(commanded change in 
position for X, Y and Z axes), 
PRX=10000 (commanded 
change in position of X axis). 

Be careful not to confuse PA 
with PR. The PR command 
begins its move from the 
current position, without 
reference to the origin. 

RS Reset. Resets the controller to its 
power on state. All the information 
in the controller’s RAM is erased. 

RS If PathMaster™ fails to 
download a file properly, the 
program may be halted in the 
controller. Executing an RS 
command from the terminal 
screen restarts the program. 

SB Set bit. Sets a bit on the output 
port. 

SB40 (sets the bit for the 
buzzer). 

Setting a bit in DMC 
terminology turns the bit off. 
The opposite of SB is CB 
(clear bit).A complete list of 
the outputs can be found in the 
Machine Specific Information 
section of the Operating Guide.

SC Stop Code   
SH Servo here. The controller uses the 

current position as the command 
position and enables motor 
control. 

SH (activate all motors), SHZ 
(activate only the Z motor). 

The opposite of SH is MO 
(motor off).SH resets all 
position errors to zero. 

SP Speed. Sets the speed for 
independent moves. Units are in 
counts per second. 

SP*=100000 (sets all axes), 
SPX=100000 (only sets the X 
axis speed), SP 
10000,30000,40000 (sets X, Y 
and Z speeds separately).  

Make sure the value of the 
acceleration is high enough to 
get the motion to speed within 
a reasonable amount of time. 

ST Stop. Halts motion on the 
specified axes. If no axes are 
specified, it halts program 
execution. 

STX (stop motion on the X 
axis), ST (stop all motion and 
halt the program). 

Use the AM command after the 
ST command to wait for 
motion to be stopped. 

TB    
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TC Tell error code. Displays the 
number and a text description for a 
command error. 

TC1  

TD Tell Dual Encoder   
TE Tell error. This returns the current 

position error of the motors. Units 
are in counts. 

TE Use this command in the 
terminal screen if a motor 
appears to be working 
incorrectly. The Dispensing 
System is programmed to 
disregard errors of less than 
1000 counts. 

TP  Tell Position. Returns the current 
position of the motors. 

TP (All axes). TPX (X axis 
only). 

Use in the terminal screen to 
verify the current location of 
the motors. In addition, the 
Manual/Jog/Teach mode of the 
Dispensing System has a push 
button that accomplishes the 
same task. 

VA Acceleration for coordinated 
moves. The units are in counts per 
second². 

VA 100000.  Make sure the value of the 
acceleration is high enough to 
get the motion to speed within 
a reasonable amount of time. 

VD Deceleration for coordinated 
moves. The units are in counts per 
second². 

VA 100000.  Make sure the value of the 
acceleration is high enough to 
get the motion to speed within 
a reasonable amount of time. 

VE Vector Sequence End   
VP Vector Position   
VS Vector Speed. Sets the speed for 

coordinated moves. Units are in 
counts per second. 

VS 100000. Query the 
controller with the command 
MG_VS. 

Make sure the value of the 
acceleration is high enough to 
get the motion to speed within 
a reasonable amount of time. 

WT Wait. Holds program execution for 
specified time. 

WT500  Use the WT command 
whenever the program needs to 
pause, particularly if another 
action needs time for 
completion. 
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Digital I/O 
The digital I/O tool allows for toggling of most digital IO points on the controller.  Find the button for the 
I/O point you wish to toggle, and click it.  The button will change colors when the I/O point changes state.  
The refresh interval is the frequency of the tool display refresh in milliseconds. 

 

Analog Input 
The analog input tool will monitor the value of analog input feedback.  The refresh interval is the frequency 
of the tool display refresh in milliseconds. 
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Resources 
The resources tool allows monitoring of controller resources such as available program labels, and program 
variables.  The type of resources displayed on this form will vary depending on the model of controller 
being used. 

 

Variable Watch 
The variable watch tool will monitor a list of program variables entered by the user.  Type a valid program 
variable name into the watch list on the left, click Start Watch and the value of the variable will be 
displayed on the right.  Multiple variables can be monitored simultaneously.  The refresh interval is the 
frequency of the tool display refresh in milliseconds. 

 



 

Refresh Communication 
If PathMaster® looses communication with the Dispensing System, select the Utilities -> Refresh 
Communications option from the main menu.  If communication is not reestablished, check cables and 
communication setting. 

Jog Toolbar 
The jog tools bar can be used to jog the X or Y axis a specified distance.  Select the Utilites -> Jog Toolbar 
option from the main menu.  Enter the distance to jog, and click the button indicating the axis and direction 
to move. 

 

Path Preview 
The path preview will give a g
segments to be displayed in th
The path preview window will 

Right click the path preview w
button to return the preview to 

Show Code 
The show code option will dis
path segments; select the Utilit
the machine code fro the select
NOTE: The jog toolbar also has a TracPad™ that can be activated to
jog the head.  Refer to the TracMouse™ section of this manual for more
information on using the TracPad™. 
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raphic representation of the path program or segments.  Highlight all path 
e preview.  Select the Utilites -> Path Preview option from the main menu.  
display: 

 

indow to reveal a zoom, pan, rotate, coordinate info menu.  Click the Reset 
its default display. 

play the compiled machine code for the selected segments.  Highlight the 
ies -> Show Code option from the main menu.  A form will open displaying 
ed segments.  The code can be saved to a text file, or printed to a hard copy. 
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DMC Error Codes 
Table 7 – DMC Error Codes 

# Description 
1 Unrecognized command 
2 Command only valid from program 
3 Command not valid in program 
4 Operand error 
5 Input buffer full 
6 Number out of range 
7 Command not valid while running 
8 Command not valid while not running 
9 Variable error 
10 Empty program line or undefined label 
11 Invalid label or line number 
12 Subroutine more than 8 deep 
13 JG only valid when running in jog mode 
14 EEPROM check sum error 
15 EEPROM checkwrite error 
16 IP incorrect sign during position move or IP given during forced deceleration 
17 ED, BN and DL not valid while program running 
18 Command not valid when contouring 
19 Application strand already executing 
20 Begin not valid with motor off 
21 Begin not valid while running 
22 Begin not possible due to Limit Switch 
24 Begin not valid because no sequence defined 
25 Variable not given in IN command 
28 S operand not valid 
29 Not valid during coordinated move 
30 Sequence segment too short 
31 Total move distance in a sequence > 2 billion 
32 More than 511 segments in a sequence 
41 Contouring record range error 
42 Contour data being sent too slowly 
46 Gear axis both master and follower 
47 Gearing and coordinated moves cannot run simultaneously 
50 Not enough fields 
51 Question mark not valid 
52 Missing " or string too long 
53 Error in {} 
54 Question mark part of string 
55 Missing [ or [ ] 
56 Array index invalid or out of range 
57 Bad function or array 
58 Unrecognized command in a command response (i.e._GNX) 
59 Mismatched parentheses 
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# Description 
60 Download error - line too long or too many lines 
61 Duplicate or bad label 
62 Too many labels 
65 IN command must have a comma 
66 Array space full 
67 Too many arrays or variables 
71 IN only valid in task #0 
80 Record mode already running 
81 No array or source specified 
82 Undefined array 
83 Not a valid number 
84 Too many elements 
90 Only X Y Z W valid operand 
95 TM too large for stepper pulse 
96 SM jumper needs to be installed for stepper motor operation 
100 Not valid when running ECAM 
101 Improper index into ET (must be 0-256) 
102 No master axis defined for ECAM 
103 Master axis modulus greater than 256*EP value 
104 Not valid when axis performing ECAM 
105 EB1 command must be given first 
118 Controller has GL1600 not GL1800 
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Cut Sheets 
 
Included on this cd are technical data sheets for componants installed on the 
Workcell. To view these documents click the button below. 
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Schematics 
 
Included on this cd is a set of  schematics for this unit.  To view these schematics 
online, click the button below. 
 
NOTE: Before you can view the schematics, you must have an AutoCAD® compatible 
viewer installed. The AutoCAD®  viewer, Volo™ View Express,  is provided on this cd. 
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Software 
 
CD ROM 
 
 

•  One (1) CD ROM is included with this manual. It contains the PathMaster® 
software used to program the Dispensing System via A windows interface. 
To “Install PathMaster®” NOTE: If you have previously installed PathMaster®, 
be sure to uninstall the old version before installing the new version. 

•  This CD also includes a few helpful tutorials explaining some of the most often 
used functions of the PathMaster® software. 

 
Note:  Your PathMaster® CD comes equipped with the ability to produce floppy disks. 
On this CD you will find a directory labeled “144 MB”. Simply copy the files from each 
disk directory to individual floppies for a complete set of installation floppy disks. 
 
 
Program (s) 
 

•  On this CD you will find a directory labeled Software it contains a backup copy 
of the main program xxxx_m01.txt, where xxxx is the serial number of the machine 
and m01 is the main program revision. The machine was shipped from Precision 
Valve & Automation, Inc. with the original copy of this main program resident in 
memory. In certain situations, a PathMaster® project backup file xxxx_P01.bck 
may also be included on the folder, where xxxx is the serial number of the 
machine and p01 is the project file revision. 

 
To prevent unitentional alteration of the files, the disk has been write-protected. 
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